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Thank you for purchasing the DL850E ScopeCorder or DL850EV ScopeCorder Vehicle Edition 
(hereinafter, “DL850E/DL850EV” will refer to both of these products).
This user’s manual explains the functions and operating procedures of the DL850E/DL850EV 
Acquisition Software. To ensure correct use, please read this manual thoroughly before beginning 
operation.
After reading this manual, keep it in a safe place.

List of Manuals
The following manuals, including this one, are provided as manuals for the DL850E/DL850EV. Please 
read all manuals.
Manual Title Manual No. Description
DL850E/DL850EV ScopeCorder 
Features Guide

IM DL850E-01EN The supplied CD contains the PDF file of this manual.  
The manual explains all the DL850E/DL850EV features 
other than the communication interface features. You can 
view the same information in the DL850E/DL850EV help 
files.

DL850E/DL850EV ScopeCorder 
User’s Manual

IM DL850E-02EN The supplied CD contains the PDF file of this manual.  
The manual explains how to operate the DL850E/DL850EV.

DL850E/DL850EV ScopeCorder 
Getting Started Guide

IM DL850E-03EN This guide explains the handling precautions and basic 
operations of the DL850E/DL850EV.

DL850E/DL850EV ScopeCorder 
Communication Interface 
User’s Manual

IM DL850E-17EN The supplied CD contains the PDF file of this manual.  
The manual explains the DL850E/DL850EV communication 
interface features and instructions on how to use them.

DL850E/DL850EV ScopeCorder
Real Time Math/Power Math
User’s Manual

IM DL850E-51EN The supplied CD contains the PDF file of this manual.  
The manual explains the features of the DL850E/DL850EV 
Real Time Math/Power Math option and how to use them.

DL850E/DL850EV ScopeCorder
Acquisition Software
User’s Manual

IM DL850E-61EN This manual. The supplied CD contains the PDF file of 
this manual. The manual explains all the features of the 
acquisition software, which records and displays data 
measured with the DL850E/DL850EV on a PC.

Precautions Concerning the 
Modules

IM 701250-04E The manual explains the precautions concerning the 
modules.

Model DL850E ScopeCorder,  
Model DL850EV ScopeCorder 
Vehicle Edition, User’s Manual 

IM DL850E-92Z1 Document for China

Model DL850E ScopeCorder,
Model DL850EV ScopeCorder 
Vehicle Edition Radio Equipment 
Directive (RED)

IM DL850E-04Z2 Document for RE directive (for /C30 option).

The “EN”, “E”, “Z1” and “Z2” in the manual numbers are the language codes.

Contact information of Yokogawa offices worldwide is provided on the following sheet.
Document No. Description
PIM 113-01Z2 List of worldwide contacts

Notes
•	 The	contents	of	this	manual	are	subject	to	change	without	prior	notice	as	a	result	of	continuing	

improvements to the instrument’s performance and functionality. The figures given in this manual 
may differ from those that actually appear on your screen.

•	 Every	effort	has	been	made	in	the	preparation	of	this	manual	to	ensure	the	accuracy	of	its	
contents. However, should you have any questions or find any errors, please contact your nearest 
YOKOGAWA dealer.

•	 Copying	or	reproducing	all	or	any	part	of	the	contents	of	this	manual	without	the	permission	of	
YOKOGAWA is strictly prohibited.

•	 The	TCP/IP	software	of	this	product	and	the	documents	concerning	it	have	been	developed/created	
by YOKOGAWA based on the BSD Networking Software, Release 1 that has been licensed from 
the Regents of the University of California.

 

7th Edition:May 2018 (YMI)
All Rights Reserved, Copyright © 2013 Yokogawa Test & Measurement Corporation
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Trademarks
•	 Microsoft,	Internet	Explorer,	Windows,	Windows	7,	Windows	8,	Windows	8.1,	and	Windows	10	are	

either registered trademarks or trademarks of Microsoft Corporation in the United States and/or 
other countries.

•	 Adobe,	Acrobat,	and	PostScript	are	trademarks	of	Adobe	Systems	Incorporated.
•	 MATLAB	is	a	registered	trademark	of	The	MathWorks,	Incorporated	in	the	United	States.
•	 In	this	manual,	the	®	and	TM	symbols	do	not	accompany	their	respective	registered	trademark	or	

trademark names.
•	 Other	company	and	product	names	are	registered	trademarks	or	trademarks	of	their	respective	

holders.

Revisions
•	 1st	Edition:		 December	2013
•	 2nd	Edition:	 July	2014
•	 3rd	Edition:	 March	2015
•	 4th	Edition:		 October	2015
•	 5th	Edition:		 July	2017
•	 6th	Edition:		 November	2017
•	 7th	Edition:		 May	2018
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Terms and Conditions of the Software License

Yokogawa	Test	&	Measurement	Corporation,	a	Japanese	corporation	(hereinafter	called	“Yokogawa”),	grants	permission	to	use	this	Yokogawa	Software	Program	(hereinafter	
called the “Licensed Software”) to the Licensee on the conditions that the Licensee agrees to the terms and conditions stipulated in Article 1 hereof.
You, as the Licensee (hereinafter called “Licensee”), shall agree to the following terms and conditions for the software license (hereinafter called the “Agreement”) based 
on the use intended for the Licensed Software.
Please note that Yokogawa grants the Licensee permission to use the Licensed Software under the terms and conditions herein and in no event shall Yokogawa intend to 
sell or transfer the Licensed Software to the Licensee.
Licensed Software Name: DL850E/DL850EV Acquisition Software
Number of Client License: 1

Article 1 (Scope Covered by these Terms and Conditions)
1.1 The terms and conditions stipulated herein shall be applied to any Licensee who purchases the Licensed Software on the condition that the Licensee consents to agree 

to the terms and conditions stipulated herein.
1.2 The “Licensed Software” herein shall mean and include all applicable programs and documentation, without limitation, all proprietary technology, algorithms, and know- 

how such as a factor, invariant or process contained therein.

Article 2 (Grant of License)
2.1 Yokogawa grants the Licensee, for the purpose of single use, non-exclusive and non-transferable license of the Licensed Software with the license fee separately 

agreed upon by both parties. Yokogawa allows the Licensee to install only one instance of the software for use on one device, whether that device is physical or virtual. 
If the Licensee want to use the software on more than one virtual device, the Licensee must obtain a separate Licensed Software for each instance.

2.2 The Licensee is, unless otherwise agreed in writing by Yokogawa, not entitled to copy, change, sell, distribute, transfer, or sublicense the Licensed Software.
2.3 The Licensed Software shall not be copied in whole or in part except for keeping one (1) copy for back-up purposes. The Licensee shall secure or supervise the copy of 

the Licensed Software by the Licensee itself with great, strict, and due care.
2.4 In no event shall the Licensee dump, reverse assemble, reverse compile, or reverse engineer the Licensed Software so that the Licensee may translate the Licensed 

Software into other programs or change it into a man-readable form from the source code of the Licensed Software. Unless otherwise separately agreed by Yokogawa, 
Yokogawa shall not provide the Licensee the source code for the Licensed Software.

2.5 The Licensed Software and its related documentation shall be the proprietary property or trade secret of Yokogawa or a third party which grants Yokogawa the rights. In 
no event shall the Licensee be transferred, leased, sublicensed, or assigned any rights relating to the Licensed Software.

2.6 Yokogawa may use or add copy protection in or onto the Licensed Software. In no event shall the Licensee remove or attempt to remove such copy protection.
2.7 The Licensed Software may include a software program licensed for re-use by a third party (hereinafter called “Third Party Software”, which may include any software 

program from affiliates of Yokogawa made or coded by themselves.) In the case that Yokogawa is granted permission to sublicense to third parties by any licensors 
(sub-licensor) of the Third Party Software pursuant to different terms and conditions than those stipulated in this Agreement, the Licensee shall observe such terms and 
conditions of which Yokogawa notifies the Licensee in writing separately.

2.8 In no event shall the Licensee modify, remove or delete a copyright notice of Yokogawa and its licenser contained in the Licensed Software, including any copy thereof.

Article 3 (Restriction of Specific Use)
3.1 The Licensed Software shall not be intended specifically to be designed, developed, constructed, manufactured, distributed or maintained for the purpose of the 

following events:
 a) Operation of any aviation, vessel, or support of those operations from the ground;,
 b) Operation of nuclear products and/or facilities;,
 c) Operation of nuclear weapons and/or chemical weapons and/or biological weapons; or
 d) Operation of medical instrumentation directly utilized for humankind or the human body.
3.2 Even if the Licensee uses the Licensed Software for the purposes in the preceding Paragraph 3.1, Yokogawa has no liability to or responsibility for any demand or 

damage arising out of the use or operations of the Licensed Software, and the Licensee agrees, on its own responsibility, to solve and settle the claims and damages 
and to defend, indemnify or hold Yokogawa totally harmless, from or against any liabilities, losses, damages and expenses (including fees for recalling the Products and 
reasonable attorney’s fees and court costs), or claims arising out of and related to the above-said claims and damages.

Article 4 (Warranty)
4.1 The Licensee shall agree that the Licensed Software shall be provided to the Licensee on an “as is” basis when delivered.  If defect(s), such as damage to the medium 

of the Licensed Software, attributable to Yokogawa is found, Yokogawa agrees to replace, free of charge, any Licensed Software on condition that the defective 
Licensed Software shall be returned to Yokogawa’s specified authorized service facility within seven (7) days after opening the Package at the Licensee’s expense. As 
the Licensed Software is provided to the Licensee on an “as is” basis when delivered, in no event shall Yokogawa warrant that any information on or in the Licensed 
Software, including without limitation, data on computer programs and program listings, be completely accurate, correct, reliable, or the most updated.

4.2 Notwithstanding the preceding Paragraph 4.1, when third party software is included in the Licensed Software, the warranty period and terms and conditions that apply 
shall be those established by the provider of the third party software.

4.3	When	Yokogawa	decides	in	its	own	judgement	that	it	is	necessary,	Yokogawa	may	from	time	to	time	provide	the	Licensee	with	Revision	upgrades	and	Version	upgrades	
separately specified by Yokogawa (hereinafter called “Updates”).

4.4 Notwithstanding the preceding Paragraph 4.3, in no event shall Yokogawa provide Updates where the Licensee or any third party conducted renovation or improvement 
of the Licensed Software.

4.5 THE FOREGOING WARRANTIES ARE EXCLUSIVE AND IN LIEU OF ALL OTHER WARRANTIES OF QUALITY AND PERFORMANCE, WRITTEN, ORAL, OR 
IMPLIED, AND ALL OTHER WARRANTIES INCLUDING ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE ARE 
HEREBY DISCLAIMED BY YOKOGAWA AND ALL THIRD PARTIES LICENSING THIRD PARTY SOFTWARE TO YOKOGAWA.

4.6 Correction of nonconformity in the manner and for the period of time provided above shall be the Licensee’s sole and exclusive remedy for any failure of Yokogawa to 
comply with its obligations and shall constitute fulfillment of all liabilities of Yokogawa and any third party licensing the Third Party Software to Yokogawa (including any 
liability for direct, indirect, special, incidental or consequential damages) whether in warranty, contract, tort (including negligence but excluding willful conduct or gross 
negligence by Yokogawa) or otherwise with respect to or arising out of the use of the Licensed Software.

Article 5 (Infringement)
5.1	If	and	when	any	third	party	should	demand	injunction,	initiate	a	law	suit,	or	demand	compensation	for	damages	against	the	Licensee	under	patent	right	(including	utility	

model right, design patent, and trade mark), copy right, and any other rights relating to any of the Licensed Software, the Licensee shall notify Yokogawa in writing to 
that effect without delay.

5.2 In the case of the preceding Paragraph 5.1, the Licensee shall assign to Yokogawa all of the rights to defend the Licensee and to negotiate with the claiming party. 
Furthermore, the Licensee shall provide Yokogawa with necessary information or any other assistance for Yokogawa’s defense and negotiation. If and when such a 
claim	should	be	attributable	to	Yokogawa,	subject	to	the	written	notice	to	Yokogawa	stated	in	the	preceding	Paragraph	5.1,	Yokogawa	shall	defend	the	Licensee	and	
negotiate	with	the	claiming	party	at	Yokogawa’s	cost	and	expense	and	be	responsible	for	the	final	settlement	or	judgment	granted	to	the	claiming	party	in	the	preceding	
Paragraph 5.1.

5.3	When	any	assertion	or	allegation	of	the	infringement	of	the	third	party’s	rights	defined	in	Paragraph	5.1	is	made,	or	when	at	Yokogawa’s	judgment	there	is	possibility	of	
such assertion or allegation, Yokogawa will, at its own discretion, take any of the following countermeasures at Yokogawa’s cost and expense.

 a) To acquire the necessary right from a third party which has lawful ownership of the right so that the Licensee will be able to continue to use the Licensed Software;
 b) To replace the Licensed Software with an alternative one which avoids the infringement; or
 c) To remodel the Licensed Software so that the Licensed Software can avoid the infringement of such third party’s right.
5.4 If and when Yokogawa fails to take either of the countermeasures as set forth in the preceding subparagraphs of Paragraph 5.3, Yokogawa shall indemnify the Licensee 

only by paying back the price amount of the Licensed Software which Yokogawa has received from the Licensee. THE FOREGOING PARAGRAPHS STATE THE 
ENTIRE LIABILITY OF YOKOGAWA AND ANY THIRD PARTY LICENSING THIRD PARTY SOFTWARE TO YOKOGAWA WITH RESPECT TO INFRINGEMENT OF 
THE INTELLECTUAL PROPERTY RIGHTS INCLUDING BUT NOT LIMITED TO, PATENT AND COPYRIGHT.
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Article 6 (Liabilities)
6.1 If and when the Licensee should incur any damage relating to or arising out of the Licensed Software or service that Yokogawa has provided to the Licensee under the 

conditions herein due to a reason attributable to Yokogawa, Yokogawa shall take actions in accordance with this Agreement.  However, in no event shall Yokogawa 
be liable or responsible for any special, incidental, consequential and/or indirect damage, whether in contract, warranty, tort, negligence, strict liability, or otherwise, 
including, without limitation, loss of operational profit or revenue, loss of use of the Licensed Software, or any associated products or equipment, cost of capital, loss 
or cost of interruption of the Licensee’s business, substitute equipment, facilities or services, downtime costs, delays, and loss of business information, or claims of 
customers of Licensee or other third parties for such or other damages. Even if Yokogawa is liable or responsible for the damages attributable to Yokogawa and to the 
extent of this Article 6, Yokogawa’s liability for the Licensee’s damage shall not exceed the price amount of the Licensed Software or service fee which Yokogawa has 
received. Please note that Yokogawa shall be released or discharged from part or all of the liability under this Agreement if the Licensee modifies, remodels, combines 
with other software or products, or causes any deviation from the basic specifications or functional specifications, without Yokogawa’s prior written consent.

6.2 All causes of action against Yokogawa arising out of or relating to this Agreement or the performance or breach hereof shall expire unless Yokogawa is notified of the 
claim within one (1) year of its occurrence.

6.3 In no event, regardless of cause, shall Yokogawa assume responsibility for or be liable for penalties or penalty clauses in any contracts between the Licensee and its 
customers.

Article 7 (Limit of Export)
 Unless otherwise agreed by Yokogawa, the Licensee shall not directly or indirectly export or transfer the Licensed Software to any countries other than those where 

Yokogawa permits export in advance.

Article 8 (Term)
 This Agreement shall become effective on the date when the Licensee receives the Licensed Software and continues in effect unless or until terminated as provided 

herein, or the Licensee ceases using the Licensed Software by itself or with Yokogawa’s thirty (30) days prior written notice to the Licensee.

Article	9	(Injunction	for	Use)
	 During	 the	 term	of	 this	Agreement,	Yokogawa	may,	at	 its	own	discretion,	demand	 injunction	against	 the	Licensee	 in	 case	 that	Yokogawa	deems	 that	 the	Licensed	

Software is used improperly or under severer environments other than those where Yokogawa has first approved, or any other condition which Yokogawa may not 
permit.

Article 10 (Termination)
 Yokogawa, at its sole discretion, may terminate this Agreement without any notice or reminder to the Licensee if the Licensee violates or fails to perform this Agreement. 

However, Articles 5, 6, and 11 shall survive even after the termination.

Article	11	(Jurisdiction)
 Any dispute, controversies, or differences between the parties hereto as to interpretation or execution of this Agreement shall be resolved amicably through negotiation 

between the parties upon the basis of mutual trust. Should the parties fail to agree within ninety (90) days after notice from one of the parties to the other, both parties 
hereby	irrevocably	submit	to	the	exclusive	jurisdiction	of	the	Tokyo	District	Court	(main	office)	in	Japan	for	settlement	of	the	dispute.

Article 12 (Governing Law)
	 This	Agreement	shall	be	governed	by	and	construed	in	accordance	with	the	laws	of	Japan.	The	Licensee	expressly	agrees	to	waive	absolutely	and	irrevocably	and	to	

the	fullest	extent	permissible	under	applicable	law	any	rights	against	the	laws	of	Japan	which	it	may	have	pursuant	to	the	Licensee’s	local	law.

Article 13 (Severability)
	 In	 the	event	 that	any	provision	hereof	 is	declared	or	 found	 to	be	 illegal	by	any	court	or	 tribunal	of	competent	 jurisdiction,	such	provision	shall	be	null	and	void	with	

respect	to	the	jurisdiction	of	that	court	or	tribunal	and	all	the	remaining	provisions	hereof	shall	remain	in	full	force	and	effect.

Article 14 (Change in Agreement)
 The contents of this contract, contents of this product, specifications of the licensed software, related support and other related services can be changed at Yokogawa’s  

discretion. However, if Yokogawa make the above changes, Yokogawa will notify them to the customer without delay.

Terms and Conditions of the Software License  



v IM DL850E-61EN

How to Use This Manual

Structure of the Manual
This manual contains 11 chapters and an index.

Chapter Title Description
1 What the Acquisition Software Can Do

Gives an overview of the Acquisition Software and the details of its functions.
2 Installation

Explains how to install and uninstall the Acquisition Software and how to install the 
USB driver.

3 Connecting to a DL850E/DL850EV
Explains how to connect the DL850E/DL850EV ScopeCorder to your PC.

4 Configuring Channels
Explains how to set measurement for each input module and how to start 
measurements.

5 Setting Measurement Conditions
Explains how to set the acquisition mode, sample rate, and the like.

6 Recording Measured Data
Explains how to record data measured by the DL850E/DL850EV on a PC or to the 
optional DL850E/DL850EV internal hard disk.

7 Display
Explains how to display waveforms of measured data and how to set the screen.

8 Saving and Loading Data
Explains how to save Acquisition Software setup data, how to load previous setup 
data, how to save measured waveforms as images, and how to save waveform data 
in the DL850E/DL850EV memory to a PC.

9 Other Features
Explains how to set the clock, the start-up and exit options, as well as how to perform 
key lock, calibration, and the like.

10 Maintenance
Describes error messages.

11 Specifications
Provides the Acquisition Software specifications.

Index
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1.1 Acquisition Software Overview

The Acquisition Software is used to connect to a DL850E/DL850EV via the USB interface or the 
Ethernet interface and record and display data that the DL850E/DL850EV has measured.
The Acquisition Software allows you to do the following:
• Set measurement and record conditions of a DL850E/DL850EV.
• Start and stop measurements on a DL850E/DL850EV.
• Start and stop recording.
• Display waveforms of the measured data, cursor values, and waveform parameters.

Signal and Data Flow
The signal and data flow between this software and the DL850E/DL850EV is described below.

  
PC (Acquisition Software)

Signal to be 
measured

Display data
Measured raw data
Current value data
SRQ (Interrupt) message
Error alarm information

HDD

Communication
processing

Display

Display data
Current value data
Error alarm information Measured 

raw data

Ethernet/USB

Xviewer*
(waveform display/analysis)

* Software sold separately

Connection
Control Commands

START / STOP

VERTICAL
CH

CH

CH

CH

CH

CH

CH

CH

CH

CH

CH

CH

CH

CH

CH

CH

1 2 3 4

5 6 7 8

9 10 11 12

13 14 15 16

HORIZONTAL TRIGGER

FFT GO / NO-GO

POSITION

COMP

DL850E/850EV

Measured raw data

Display Data
P-P compression data that the DL850E/DL850EV creates for displaying waveforms.

Measured Raw Data
All the measured data that the DL850E/DL850EV acquired. The data is sent to a PC to be stored on 
the its hard disk.
You can use Xviewer, sold separately, to display waveforms and analyze data.

Current Value Data
Current value data is instantaneous data calculated by the DL850E/DL850EV. The data is sent 
immediately in response to a request from a PC.

SRQ (Interrupt) Message
A service request message that indicates measurement end, error occurrence, and other events 
detected by the DL850E. The message is handled using an interrupt provided by the VISA interface on 
a PC.

Error and Alarm Information
Errors and alarms that occur during DL850E/DL850EV measurement can be displayed.

Chapter 1 What the Acquisition Software Can Do
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Monitoring (Measurement) and Recording
This software refers to the task of acquiring measured data into the internal memory of a DL850E/
DL850EV as monitoring (measurement) and the task of saving the measured data that has been 
acquired to the internal memory of a DL850E/DL850EV as files on your PC’s hard disk or the internal 
hard disk of a DL850E/DL850EV while making measurements as recording.
The measured data acquired in the internal memory of a DL850E/DL850EV is cleared when the power 
is turned off and then turned back on or when measurement is resumed. The waveform window of 
this software displays waveforms of measured data acquired to the internal memory of a DL850E/
DL850EV after applying P-P compression.

 

PC
DL850E/DL850EV

Signal to be measured

HDD

Display

HDDMemory

Measure

Record

Record
Monitor

When a measurement is complete, the measured data acquired in the internal memory of a DL850E/
DL850EV can be saved as a single file on your PC.
This is task is referred to as saving, not recording.

Connecting to a DL850E/DL850EV
The USB interface can be used to connect your PC directly to a DL850E/DL850EV, or the Ethernet 
interface can be used to connect to a DL850E/DL850EV over the network.
Only a single DL850E/DL850EV can be connected to a single PC.

Note
• Before removing the USB or Ethernet cable that is connecting the DL850E/DL850EV to the PC, be sure 

to close the Acquisition Software or disconnect the communication between the DL850E/DL850EV and 
the PC.

• To connect through USB, you need a dedicated USB driver. For details, see section 2.3, “Installing the 
USB Driver.”

• You cannot connect both Ethernet and USB interfaces simultaneously to a DL850E/DL850EV. Therefore, 
it is not possible to use FTP or other network connection programs over Ethernet to connect to a DL850E/
DL850EV that this software is already connected to using USB.

•  When connecting a DL850E/DL850EV to the PC, disable the PC standby mode. If it is enabled, the 
connection between the DL850E/DL850EV and the PC may be disconnected.

• If the network becomes unstable due to network applications or the like, the DL850E/DL850EV may not 
be able to record properly. If you want to record continuously for a long period of time, check that the 
network is capable of long-term stable communication in advance.

• You will not be able to connect if the DL850E/DL850EV is configured to reject connection requests from 
the Acquisition Software.

1.1  Acquisition Software Overview
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Workflow
The workflow to make measurements using the Acquisition Software varies depending on whether it is 
the first time that you are connecting to the DL850E/DL850EV.

If Connecting to the DL850E/DL850EV for the First Time

* To connect via USB, a USB driver must be installed.

Start monitoring (measuring)

Start recording

Configure the system

Configure the channels

Set the record conditions

Set the display conditions

Connect the DL850E/DL850EV to a PC 
via Ethernet or USB*

Set the measurement conditions

Select the DL850E/DL850EV to connect to
Register the channels to acquire measured data

Set the vertical scale, input coupling, etc. (chapter 4)

Set the recording destination (chapter 6)
Set file information (chapter 8)

Set the display group (section 7.1) 
(Register the channels to be displayed on a waveform screen)
Set the scale (section 7.1)
Set the zone (section 7.1)
Set the waveform color and thickness (section 7.1)
Set the vertical and horizontal axes (section 7.1)

Set the measuring mode (section 5.1)
Set the acquisition mode (section 5.1)
Set the sample rate and sample interval (section 5.2)

1.1  Acquisition Software Overview
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If Reconnecting to the DL850E/DL850EV
Connect to the DL850E/DL850EV

Start the Acquisition Software (section 2.4)

(IM DL850E-03EN, a separate manual)

Configure the system

Set the display conditions

When the DL850E/DL850EV is started with
 the previous setup file (section 9.2)

When making measurements by changing 
the measurement conditions

Start monitoring (measuring)

Start monitoring (measuring)

Change the settings as necessary

* For details on each setup item, see the operation flow diagram 
“Connecting to the DL850E/DL850EV for the First Time.”

Configure the channels

Set the record conditions

Set the measurement conditions

Start recording

Start recording

1.1  Acquisition Software Overview
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Setup in Wizard Format
The basic setup consisting of system configuration, channel settings, measurement (FreeRun) 
settings, recording (File) settings, and display settings can be specified easily using dialog boxes in 
wizard format. You can also use icons and the menu bar to specify system configuration, measurement 
settings, recording settings, and display settings individually.

 

Next Back

Channel Settings screen
For the operating procedure, 
see chapter 4.

FreeRun Settings screen
For the operating procedure, 
see chapter 5.

File Settings screen
For the operating procedure, 
see chapter 6.

Acquisition menu

Acquisition menu

Acquisition menu

Acquisition menu

Next Back

Next Back

BackNext

System Configuration screen
For the operating procedure, 
see chapter 3.

File Settings screen
For the operating procedure,
see chapter 6.

Next page

1.1  Acquisition Software Overview
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Display Settings screen
For the operating procedure, 
see chapter 7.

Acquisition menu

1.1  Acquisition Software Overview
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1.2 System Configuration

Communication Device
Select the interface to use to communicate with the DL850E/DL850EV: USB or Ethernet. The 
Acquisition Software can communicate with the DL850E/DL850EV that is connected to the interface 
you select.
The Ethernet interface can be used on a DL850E/DL850EV with the /C10 option.

Searching for the DL850E/DL850EV
You can search for the DL850E/DL850EV that is to communication with the PC.
For USB, all the DL850E/DL850EVs connected through USB can be searched.
For Ethernet, all the DL850E/DL850EVs connected to the network can be searched (auto search) or a 
specific IP address can be searched for.

Auto Search
All the DL850E/DL850EVs connected to the network are searched, and their serial numbers and IP 
addresses are displayed.

IP Address
You can search for a specific DL850E/DL850EV by specifying the IP address.

Measuring Source Channels
Select the channels to acquire measured data.
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1.3 Channel Settings

This section explains settings that are specified for each measuring channel, such as input coupling, 
probe attenuation, and bandwidth limit.

Input Coupling
The following types of input coupling are available.

DC
The input signal is directly coupled to the attenuator of the vertical control circuit. Select DC if you want 
to measure the entire vertical input signal (DC and AC components).

AC (Only When Measuring the AC Voltage)
The input signal is coupled to the attenuator of the vertical control circuit through a capacitor. Select 
AC if you want to measure only the amplitude of the AC signal, eliminating the DC components from 
the input signal.

GND
The input signal is coupled to the ground, not to the attenuator of the vertical control circuit. Select 
GND to check the ground level on the window.

TC (Only When Measuring the Temperature)
Select TC if you are measuring the temperature using the 701261 (UNIVERSAL), 701262 (UNIVERSAL 
(AAF)), 701265 (TEMP/HPV), 720221 (16CH TEMP/VOLT), or 720266 (TEMP/HPV).

DC-RMS
Using the 701267 (HV (with RMS)) or 720268 (HV (with RMS/AAF)), both the DC and AC components 
of the input signal are converted to rms values and displayed. An RMS conversion circuit is connected 
to the vertical control circuit of the same input coupling circuit used when the coupling is set to DC.

AC-RMS
Using the 701267 (HV (with RMS)) or 720268 (HV (with RMS/AAF)), only the AC component of the 
input signal is converted to rms values and displayed. An RMS conversion circuit is connected to the 
vertical control circuit of the same input coupling circuit used when the coupling is set to AC.

ACCL (Only When Measuring Acceleration)
Select ACCL to measure acceleration using the 701275 (ACCL/VOLT).

Probe Attenuation and Current-to-Voltage Conversion Ratio
When using a probe, the attenuation setting on the DL850E/DL850EV must be set equal to the probe 
attenuation or current-to-voltage conversion ratio so that the measured voltage (current) can be read 
directly.
The DL850E/DL850EV has the following attenuation settings: 1:1, 10:1, 100:1, 1000:1, 1 A:1 V,1 
10 A:1 V,2 100 A:1 V,3 400 A:1 V.4 When using a probe, set the attenuation ratio on the DL850E/
DL850EV according to the attenuation of the probe.

1 Output voltage rate: 1 V/A
2 Output voltage rate: 0.1 V/A
3 Output voltage rate: 0.01 V/A
4 Output voltage rate: 0.0025 V/A

Note
Use a probe that matches the input capacity of each module. Otherwise, the capacity cannot be adjusted.
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Vertical Scale
Set the vertical scale (V/div) according to the input signal.
Select a TC type when measuring temperature.

Bandwidth Limit
You can set a upper bandwidth limit on the analog signal for each channel. This allows you to observe 
waveforms with noise components above the specified frequency removed.

Linear Scaling
The measured data can be scaled to any physical value and displayed.
When measuring the voltage (current), strain, or frequency (number of rotations, period, duty cycle, 
power supply frequency, pulse width, pulse integration, and velocity), there are two methods of linear 
scaling: “aX+b” and “P1-P2.”

aX+b
The results obtained from the following computation based on the specified scaling coefficient a 
and offset b are displayed as cursor measurement values and automated measurement values of 
waveform parameters.
 Y = aX + b

P1-P2
Specify arbitrary scale values (P1Y and P2Y) for the measured values of two arbitrary points (P1X and 
P2X). The scaling equation (y = ax + b) is derived from these four values.

Waveform Inversion
When measuring voltage or strain, the waveform can be displayed with the vertical axis inverted 
around the ground level or the strain balance level as shown below.

  Ground level or
strain balance level

Normal display Inverted display

1.3  Channel Settings
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RMS Measurement
When a 701267 (HV (with RMS)) or 720268 (HV (with RMS/AAF) channel is selected, you can observe 
the RMS values of the input signal.

AC-RMS
This setting is used when you want to observe only the rms values of the AC signal, eliminating the DC 
components from the input signal.

DC-RMS
This setting is used when you want to observe the rms values of both the DC and AC components of 
the input signal.

Temperature Measurement
Thermocouple Type
The following types of thermocouples are available.
K, E, J, T, L, U, R, S, B, N, W, Au7Fe

Selectable Temperature Units
You can select °C or K.

Reference Junction Compensation (RJC)
The voltage generated by a thermocouple depends on the temperature of the point of measurement 
and the reference junction temperature. In this case, the function used to compensate the temperature 
on the measurement instrument to the cold junction is referred to as reference junction compensation.
You can turn ON/OFF the internal RJC circuit of the input module.
ON: Use this setting to enable the reference junction compensation by the internal RJC circuit.
OFF:  Use this setting to check the temperature measurement value or to use an external reference 

junction (0°C).

Burnout
Specify the behavior when the thermocouple input detects a burnout.
ON:  Fix the measured value to the upper limit of the measurement range of each thermocouple if a 

burnout is detected.
OFF: Not detect burnouts.

1.3  Channel Settings
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Strain Measurement
You can measure strain by connecting a strain gauge bridge (bridge head) or a strain gauge 
transducer to the Strain Module (701270 (STRAIN_NDIS) or 701271 (STRAIN_DSUB)).

Relationship between the Strain (μSTR) and the Transducer 
Output (mV/V)
The DL850E/DL850EV allows the unit to be changed between “the strain unit (μSTR: ×10–6 strain)” 
and “the output unit of the strain gauge transducer (mV/V).” The following relationship exists between 
μSTR and mV/V.
 (mV/V) = 0.5 × (μSTR)/1000

Gauge Factor If mV/V Is Selected
You can set the gauge factor to any value on the DL850E/DL850EV. However, if there are no 
specifications on the strain gauge transducer, set K to 2.
If K is not 2, e is derived in the DL850E/DL850EV using the following equation.
 e = (4/K) × (V/E)
  e: Measured value of the strain gauge transducer [mV/V]
  V: Voltage measured on the bridge [V]
  E: Voltage applied to the bridge [V]
  K: Gauge factor

Acceleration Measurement
The Acceleration Module (with AAF) (701275 (ACCL/VOLT)) measures acceleration using the 
output signal from an acceleration sensor. Direction connection is possible to a built-in amplifier type 
acceleration sensor.

Filter
If you set the bandwidth limit to Auto, the anti-aliasing filter (AAF) and low-pass filter are enabled 
depending on the sample rate to eliminate high-frequency noise from the input signal.

Note
The filter is effective not only during acceleration measurement but also during voltage measurement.

1.3  Channel Settings
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Frequency Measurement
Measured Item
The Frequency Module (701281 (FREQ) or 720281 (FREQ)) measures frequency, number of rotations, 
period, duty cycle, power supply frequency, pulse width, pulse integration, and velocity.

Decelerating Prediction and Stop Prediction
The 701281 (FREQ) or 720281 (FREQ) automatically performs internal computation and displays 
waveforms by predicting the deceleration curve and stop point even when the input pulse is suddenly 
cut off.

Decelerating Prediction
 The deceleration curve is computed according to the following equation using the elapsed time after 

the pulse input stops (Δt).
 Frequency (f) = 1/period (Δt)

Stop Prediction
 The function determines the stop point at a constant time after the pulse input stops, and the 

frequency is set to 0.

Filter
Smoothing filter (moving average)
The frequency module can display waveforms by taking the moving average of the data in real-time.

Pulse Average
Measures the input pulse by dividing the pulse by the specified number of pulses (1 to 4096 pulses).

Offset Function
The 701281 (FREQ) or 720281 (FREQ) allows you to set the center of observation (offset value) and 
expand the area around the offset value for close observation.

Power Supply Analysis, CAN Bus Signal Measurement, LIN Bus 
Signal Measurement, SENT Signal Measurement

This software cannot be used to configure power supply analysis. Nor can it be used to configure 
CAN bus signal measurement, LIN bus signal measurement, or SENT signal measurment using CAN 
bus Monitor Modules (720240), CAN & LIN Bus Monitor Modules (720241), CAN/CAN FD Monitor 
Modules (720242), or SENT Monitor Modules (720243). Configure them from the DL850E/DL850EV. 
YOKOGAWA’s free software Symbol Editor is convenient for setting CAN bus or LIN bus signals. 
You can download Symbol Editor from YOKOGAWA website. You can download Symbol Editor from 
YOKOGAWA website.

1.3  Channel Settings
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1.4 Measurement Conditions (FreeRun Settings)

This section briefly explains the DL850E/DL850EV measurement conditions that can be specified 
using this software. For details, see the DL850E/DL850EV User’s Manual, IM DL850E-01EN, (pdf file).

Measuring Mode
The only available measuring mode is free run.

Free Run Mode
In free run mode, data is acquired immediately when measurement is started. Data acquisition 
continues until measurement is stopped.

Acquisition Mode
When acquiring measured data in the internal memory of the DL850E/DL850EV, it is possible to 
perform processing on data and display waveforms based on the processed data. The following three 
types of data processing are available.

Normal Mode
In this mode, measured data is acquired without special processing.

Envelope Mode
The DL850E/DL850EV determines the maximum and minimum values among the data sampled at the 
maximum sample rate for each module at a time interval that is twice the sampling period (the inverse 
of the sample rate) of Normal mode, saves the values as pairs in the acquisition memory, and uses the 
saved value pairs to display the waveforms.

Box Average Mode
This mode is available on the 701250 (HS10M12), 701255 (NONISO_10M12), 720210 (HS100M12), 
720211 (HS100M12) and 720250 (HS10M12). In this mode, the DL850E/DL850EV determines the 
moving average of the data sampled at the maximum sample rate and acquires and displays the 
resultant data.

Sample Rate and Sample Interval
You can set the sample rate or sample interval.
The sample rate (the number of samples per second in unit of S/s) is related to the sample interval as 
follows:
 Sample Rate = 1/sample Interval

Sample rate = 1/sample interval If you set a sample rate that exceeds the maximum sample rate of a 
module, data cannot be acquired at the specified sample rate. The data at times when data cannot be 
acquired is set to the same value as the previous acquired data.
The maximum sample rate varies depending on number of measuring channels.

No. of Measuring Channels* Maximum Sample Rate
1 1 MS/s
2 or 3 500 kS/s
4 to 8 200 kS/s
9 to 16 100 kS/s

 *  Measuring channels do not include sub channels.

Division Conditions
Measured data file that is recorded from when recording is started until recording is stopped is divided 
at specified time intervals and saved.
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1.5 Recording Conditions (File Settings)

Auto Recording Destination
Measured data is recorded to the specified hard disk.
The following three recording destinations are available.
• PC HDD:   Records on the hard disk of the PC in which this software is installed.
• DL850E HDD:  Records on the DL850E/DL850EV hard disk. You cannot specify this setting on a 

DL850E/DL850EV without a hard disk.
• PC HDD +DL850E HDD:  

       Records both on the PC and DL850E/DL850EV hard disks. You cannot specify 
this setting on a DL850E/DL850EV without a hard disk.

The remaining space on the PC or DL850E/DL850EV hard disk can be displayed on the window.
When recording on a PC hard disk, you can specify the save destination folder. A folder with the 
following name is created in the specified folder, and data is save in the folder.

  Year
Month

Day

Sequence number

20131230_000 (2013/12/30; sequence number: 000 to 999)

Starting and Stopping Recording
To start recording, click the Start Recording button or Start Recording on the Acquisition menu.
To stop recording, click the Stop button or Stop Recording on the Acquisition menu.

Note
The recordable time varies depending on the following conditions.
• The amount of free space on the recording destination hard disk
• The number of measuring channels
• The sample rate
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File Name
To Use the Date/Time in the File Name
The date/time (ms unit) of the recording is used for the file name. A specific file name cannot be 
specified.

  
Year

Month
Day

Hour
Minute

Second
ms

20131230_121530_100_000 (2013/12/30 12:15:30.100)
In Free Run Mode

Sequence number when a single file 
exceeds 2 GB (000 to 999)

To Use a Sequence Number in the File Name
A sequence number is added to a file name that you specify.

  
TEST0000_000 

Character string
Sequence number (0000 to 9999)

In Free Run Mode

Sequence number when a single file exceeds 2 GB (000 to 999)

File Order
There are two methods for recording measured data to the hard disk of your PC or the DL850E/
DL850EV: sequential and cyclic.

Sequential
Records the files sequentially to the hard disk. This method is useful if you want to retain the old data. 
If the number of recordings is large, the free space on the hard disk may run out.

Cyclic
Records the specified number of files. If the specified number is exceeded, the file is overwritten in 
order from the oldest one. This method is useful if the free space on the hard disk is low.

1.5  Recording Conditions (File Settings)
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1.6 Display Settings

Display Group
The measured data on measuring channels that are enabled in the system configuration can be 
divided and displayed in four groups (display group 1 to 4). Up to 32 channels can be registered in a 
group. The same channel can also be registered to multiple groups.
The measured data of channels in the same group (display group 1) can be compared using cursor 
values and values obtained through automated measurement of waveform parameters.

Scale
You can set the display range. If linear scaling is set on the channel, the range is specified using a 
scaled value.
It is also possible to automatically set a scale based on the measured data.

Zone
You can set the position to display the waveform.
The display position is set in terms of a percentage of the window.
This feature keeps waveforms from overlapping when displaying multiple waveforms on a single 
window.
The following example shows the case when the display zone of waveform A is set to 30% to 100% 
and that of waveform B is set to 0% to 70%.

  

A

B

0

30

100

70

Displays Other Than Waveforms
Current Value Display
The current measured value is displayed using a bar graph, digital display (numeric), analog meter, or 
thermometer.
Current values are measured data that this software retrieves from the DL850E/DL850EV at 100-ms 
intervals.

Numeric Value Display
Displays the measured values at the cursor positions.
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1.7 Analysis Function

Cursor Measurement
There are two types of cursors: horizontal and vertical. Two cursors are displayed for each type of 
cursor. The measured values at the two cursor positions and the difference between the cursors can 
be displayed.
You can move the cursor directly by dragging it or by using the left, right, up, and down arrow keys on 
the keyboard. If you are dragging the cursor, the cursor moves in steps of screen dots.
If you are using the left, right, up, and down arrow keys, the vertical cursor moves over the measured 
data. The speed at which the cursor moves varies depending on the number of measured data points 
displayed on the screen. If the number of measured data points is greater than the number of dots on 
the waveform window, the cursor moves on all the measured data points that are displayed at the dot 
before moving to the next dot. Therefore, the cursor will move slower.
If multiple waveforms with different sample rates are displayed on the same window, the cursor moves 
according to the sample rate of the cursor target waveform.

  

Cursor movement

For waveforms with low sample rate For waveforms with high sample rate

Cursor movement

Measured value that cannot be read 
with cursors

Displays the same value as the 
previous measured value because 
there is no measured data
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1.8 Window Description

Main Window

Menu bar
Toobar

Status bar

Recording buffer

Waveform screen

Measurement state

Record state
Over-range

Remaining hard disk indicator File information

Information about the hard disk of your PC or 
the internal hard disk of the DL850E/DL850EV

Information about the Hard Disk of Your PC or the Internal Hard 
Disk of the DL850E/DL850EV
Displays information about the hard disk of your PC or the internal hard disk of the DL850E/DL850EV.
You can switch the displayed hard disk using tabs.

File Information
 Displays the file name, save time, data size, and the like of the measured data or setup data that 

are saved.

Record State
 The lamp is red while recording to the hard disk.

Remaining Hard Disk Indicator
 Displays the remaining hard disk space in megabytes (MByte). If the remaining space falls low, the 

bar turns red.

Measurement State
Displays the current measurement state.

Recording Buffer
Displays a bar that indicates buffer usage. The closer the recording buffer usage gets to overrunning 
the buffer, the longer the blue bar becomes. For example, this situation occurs when recording cannot 
keep up with the measured data.

Over-Range
Turns red when an over-range occurs. Double-click to display an over-range list screen showing a list 
of channels that over-range is occurring on.
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Waveform Window

Numeric value display areaWaveform display area

Maximum sample rate
Measuring mode

Scale

Active waveform

Magnification

Zone

Adjusts the grid 
brightness

Adjusts the background 
brightness of the waveform 
display area (highlighted 
display)

Changes the ratio of the waveform display 
area to the numeric value display area

Turns ON/OFF 
the zone display

Turns ON/OFF the 
waveform display

Active Waveform
The waveform with a triangle mark is the active waveform.

Scale
Displays the scale according to the display settings. If zones are specified with overlapping scales, the 
scale of the active waveform is displayed.

Measuring Mode
Displays “Free Run.”

Sample Rate
Displays the sample rate of the displayed waveform.

Adjusting the Brightness of the Grid (Graticule)
Drag the knob to change the brightness of the grid.

Adjusting the Background Brightness of the Waveform Display 
Area (Highlighted Display)
Slide the knob to change the background of the waveform display from black to white in steps.

Turning ON/OFF the Waveform Display
Click this area to turn the channel display on and off. Channels that are displayed are indicated in light 
blue.

Turning ON/OFF the Zone Display (Sliding Window)
Move the pointer over this area and click when this area changes to light purple to turn the zone 
display area on and off.

Main Waveform or Zoom Waveform
The displayed waveform is indicated by the blue frame.

Changing the Ratio of the Waveform Display Area to the Cursor 
Value Display Area
Drag when the pointer changes to a left-right arrow to change the ratio of the display areas.

Time Display
In Free Run mode, the displayed time range is displayed along with the elapsed time.

1.8  Window Description
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Menu Bar
 

File Menu
A menu used to save and load setup files, to save image data, and so on.

Acquisition Menu
A menu used to (1) specify system configuration, channel settings, measurement settings, recording 
settings, and display settings, (2) start and stop monitoring (measurement), (3) start and stop, and (4) 
hold and resume the display.

View Menu
A menu used to (1) show and hide operating information, (2) set waveform zooming, display zones, 
measured value display, (3) show and hide current values, full-screen display, toolbar, and status bar.

Window Menu
A menu used to set the waveform window. This menu appears when the waveform window is 
displayed.

Environment Menu
A menu used to enter environment settings, enable and disable the key lock on the DL850E/DL850EV, 
and calibrate the DL850E/DL850EV.

Utility Menu
A menu used to start Xviewer (sold separately) and File Utility.

Help Menu
A menu used to display help and software version.

Toolbar
Click the buttons on the toolbar to execute a certain operation or display a setup menu.

 

Start Recording button

Open button

Start Monitoring (measurement) button

Display Hold button

Display Resume button

Stop Monitoring (measurement)/Recording button

Display Group button

Display Settings button

File Settings buttonChannel Settings button

Connection Settings button

Version display button

FreeRun Settings button

1.8  Window Description
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1.9 Other Features

Saving the Setup File
The setup entered using this software can be saved.

Accumulating Waveforms
You can accumulate waveforms on the window, retaining the old waveforms. This is useful when you 
want to observe fluctuations in the measured data.

Taking Snapshots
You can change the display color of the waveforms that you want to keep on the window and retain 
just those waveforms. This is useful when you want to compare waveforms.

Automatically Displaying Waveforms from Memory
You can set the DL850E/DL850EV to automatically display the measured data in its acquisition 
memory.
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1.10 Basic Operation

This section explains the basic operation of this software.

Text Box
You can directly type a value or text. Click the box to show the text cursor or highlight an existing value 
and type from your keyboard.

 

Text cursor

Option Button
You can select one of the option buttons.

 

Option button

Check Box
You can select multiple items from the available items. Clicking a selected check box clears it.

 

Check box

Drop-Down List Box
Click by the  box to display a list of available choices.

 
Drop-down list box

Selecting Lines
To select a line on a setup window displayed in table format, click the beginning of the line. To select all 
lines, click the upper left corner of the table. To select consecutive lines, click the first line you want to 
select and press the last line while holding down the Shift key.

 

Click here to select or unselect all lines

Selected lines
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Collectively Selecting or Clearing the Check Boxes of the Selected 
Items
On a setup window displayed in table format, you can collectively select or clear the check boxes in a 
selected range.
Select multiple lines containing the check boxes you want to manipulate as described earlier.
Click  at the bottom of the check box items to collectively select or clear the check boxes in the 
selected range.

 

Selected lines

Select or clear the check boxes collectively

Click here to collectively select or clear 
the check boxes of the selected lines.

Setting the Value of the First Line in the Selected Range to the 
Other Lines in the Selected Range
On a setup window displayed in table format, you can set the values in the selected range to the same 
value as the value of the first line in the selected range.
Select multiple lines containing the check boxes you want to manipulate as described earlier.
Click  at the bottom of the items. The values in the selected range are set to the value of the first line 
in the selected range.

 

Click here to set the values in the selected range to 
the same value as the first line in the selected range

Selected lines

Set to the same value as the first line 
in the selected range

1.10  Basic Operations



2-1IM DL850E-61EN

Installation

1 

2 

3 

4 

5 

6 

7 

8 

9 

10 

11

Index

2.1 PC System Requirements

Install this software on a PC with the following specifications.

Operating System
Windows 7 (32-bit/64-bit), Windows 8 (32-bit/64-bit), Windows 8.1 (32-bit/64-bit), or Windows 10 
(32-bit/64-bit)

CPU
Core2 Duo 2 GHz or better

Memory
At least 1 GB (at least 2 GB recommended)

Hard Disk
At least 2 GB of free space (before installation)
At least 100 GB recommended when using the auto recording function.

Communication Interface
USB2.0
Ethernet 1000BASE-T

CD-ROM Drive
A CD-ROM drive is required to install this software program.

CRT and Mouse
Display:   XGA or better
Color:   65536 colors or better
The mouse must be compatible with Windows 7 (32-bit/64-bit), Windows 8 (32-bit/64-bit), Windows 8.1 
(32-bit/64-bit), or Windows 10 (32-bit/64-bit).

Chapter 2 Installation
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2.2 Installing or Uninstalling the Acquisition 
Software

Installing the Acquisition Software
The following procedure explains how to install the software on Windows 7.

1. Start Windows and log on with administrator privileges.

2. Load the Acquisition Software installation disk into the CD-ROM drive.  
The installer starts automatically, and setup begins.

3. The installation wizard window appears.

 Click Next.

   

4. A software licensing agreement appears. Review the licensing agreement, and click “I accept 
the terms in the license agreement,” and then click Next.

 If you click “I do not accept the terms in the license agreement,” you will not be able to install 
the software.
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5. User information registration window appears. Enter the user name and affiliation, and click 
Next.

   

6. A window for setting the installation destination appears. The default settings is C\Program 
Files\Yokogawa\DL850E Acquisition Software. To change the destination, click Change and 
select the desired directory. Check the installation destination and click Next.

   

7. A window prompting you to start the installation appears. If there is no problem with the 
installation settings, click Install.

   

2.2  Installing or Uninstalling the Acquisition Software
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8. The software installation starts. When the software installation finishes normally, the following 
window appears.

 Click Finish.

   

 You are finished with the installation. Yokogawa > DL850EACQ is added to Start > Programs. A 
shortcut is also added to the desktop.

Uninstalling the Acquisition Software
This section explains how to uninstall the software on Windows 7.

1. On the Windows Start menu, click Control Panel.

2. Double-click Programs and Features in the Control Panel.

3. Select DL850EACQ, and click Uninstall.

4. A uninstallation confirmation window appears. To uninstall, click Yes. Click No to cancel the 
uninstallation.

5. The software is uninstalled.

2.2  Installing or Uninstalling the Acquisition Software
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2.3 Installing the USB Driver

A dedicated USB driver (YKMUSB) or IVI driver (VISA) is necessary to connect the DL850E/DL850EV 
to your PC using the USB.
The dedicated USB driver (YKMUSB) is provided in the Acquisition Software CD.
For the installation procedure, see the manual in the CD.
The dedicated USB driver (YKMUSB) is in the “\YKMUSB” folder.
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2.4 Starting and Exiting the Acquisition Software

Starting the Software
Double-click the DL850EACQ icon on the desktop.
The Acquisition Software starts.

Start-up Operation
The System Configuration window appears.

 

If you selected the Previous Settings check box in Environment Settings the last time you used the 
Acquisition Software, the software starts with the previous settings (see section 9.2). If the module 
configuration is different from the previous time or if the settings cannot be updated using the same 
conditions, the following message appears.
The same applies if you load the settings from a previously saved setup file and the settings of the 
software and the DL850E/DL850EV are updated.

Messages and Their Descriptions
 The messages that may appear at start-up are described below.

Message Description
Cannot find DL850E/DL850EV. DL850E/DL850EVs cannot be detected using the search 

conditions used the last time the software was exited or the search 
conditions of the setup file. Below are some possible reasons.
• The communication cable is disconnected.
•  If the connection method is Ethernet, the specified TCP/IP 

address and the TCP/IP address of the DL850E/DL850EV are 
different.

The connected DL850E is being remotely 
controlled by another application.
Close the other application and connect 
to the DL850E again.

This software cannot connect because the DL850E/DL850EV is 
being controlled from another PC.
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2.4  Starting and Exiting the Acquisition Software

Message Description
Configuration of the system are different. The system configuration that existed when the software was 

exited the last time or that of the setup file is different from that of 
the connected DL850E/DL850EV.
If you change, add, or remove the modules installed in 
the DL850E/DL850EV, the software considers the system 
configuration to be different.

To execute this operation, stop 
measurement first.

The connected DL850E/DL850EV is measuring.

Turn OFF HD Recording before 
Connecting the DL850E.

The connected DL850E/DL850EV is performing hard disk 
recording.

Current Firm Version is not supported, 
you will not be able to connect.

Appears when the Acquisition Software version is incompatible 
with the DL850E firmware. Update the Acquisition Software or 
the DL850E firmware. (See the software and DL850E/DL850EV 
firmware version compatibility table.)

• Software and DL850E/DL850EV firmware version compatibility table
Software version  
of this software DL850E/DL850EV firmware version

1.01 to 1.03 3.00 or later but earlier than 3.20
1.04 3.20 or later but earlier than 4.00
1.05 to 1.08 4.00 or later but earlier than 4.20 
1.09 or later 4.20 or later 

 Downloading the latest version:  
  http://tmi.yokogawa.com/products/data-acquisition-equipment/scopecorders/dl850edl850ev-

scopecorder/

Corrective Action
 The corrective action that is displayed along with the message is described below.

Corrective Action Description
Get settings from the DL850E. Discard the settings that were loaded and receive the settings 

from the DL850E/DL850EV. The measurement or recording on the 
DL850E/DL850EV continues.

Stopping measurement and sending 
settings to the DL850E.

If the DL850E/DL850EV is measuring, the settings cannot 
be updated. Stop the measurement and update the DL850E/
DL850EV settings using the settings of this software.

Exiting the Software
On the File menu, click Exit. The setup data is automatically saved.
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3.1 Connecting Using the USB

Connect the USB port for PCs of the DL850E/DL850EV to your PC using a USB cable.
If you are connecting the DL850E/DL850EV to your PC for the first time after purchase, you must 
install the USB driver. Install the USB driver in your PC by following the instructions given in section 2.3, 
“Installing the USB Driver.”

1. Start the software. 
The System Configuration window appears.

 If the Previous Settings check box in Environment Settings is selected, the main window 
appears. If this happens, display the System Configuration window from the Acquisition menu.

2. Set the connection method to USB.

3. Click Search. 
The channel configuration of the connected DL850E/DL850EV is displayed.

Click USB. Executes the search

Applies the settings and closes the window

The connected DL850E/DL850EV

Move to different settings windows.

Channel configuration of the 
connected DL850E/DL850EV

Configure real time math settings.
Select measuring channels.

Cancels the settings and closes 
the window

Moves to the Channel Settings 
screen

4. Select the channels you want to measure.

5. Moving to another setting window or clicking OK will establish a connection with the selected 
DL850E/DL850EV.

Note
• If the channel configuration of the DL850E/DL850EV does not appear, the connection may have failed. 

Check the USB cable connection, and search again.
• For details on real-time math, see the DL850E/DL850EV User’s Manual.

Chapter 3 Connecting to a DL850E/DL850EV
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3.2 Connecting Using the Ethernet

Connect the DL850E/DL850EV to a PC over an Ethernet network.

1. Start the software. 
The System Configuration window appears.

 If the Previous Settings check box in Environment Settings is selected, the main window 
appears. If this happens, display the System Configuration window from the Acquisition menu.

2. Set Connection Method to Ethernet.

3. Select Autodetect or IP. If you select IP, enter the IP address of the DL850E/DL850EV you 
want to connect to. Click Search.
If you select Autodetect, the DL850E/DL850EVs connected to the network are displayed.
If you specified an IP address, the specified DL850E/DL850EV is searched for.

4. From the displayed DL850E/DL850EVs, select the DL850E/DL850EV you want to connect to.
The channel configuration is displayed.

Click Ethernet. Select this to search by specifying an IP address.

Select this to search without specifying an IP address.

Executes the search

The serial numbers and IP addresses of the detected DL850E/DL850EVs
The DL850E/DL850EV shown in red is connected to another PC.

Move to different settings windows.

Channel configuration of the 
connected DL850E/DL850EV

Configure real time math settings.
Select measuring channels.

Applies the settings and closes the window

Cancels the settings and closes 
the window

Moves to the Channel Settings 
screen

5. Select the channels you want to measure.

6. Moving to another setting window or clicking OK will establish a connection with the selected 
DL850E/DL850EV.

Note
• If the channel configuration of the DL850E/DL850EV does not appear, the connection may have failed. 

Check the Ethernet cable connection, and search again.
• To connect using Ethernet, you must set the IP address and other parameters of the DL850E/DL850EV in 

advance.
• For details on real-time math, see the DL850E/DL850EV User’s Manual.
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3.3 Changing the Connected Device

1. Click the System Configuration button, or click System Configuration on the Acquisition 
menu.

   
Channel Settings buttonDisplays the Acquisition menu

The System Configuration window appears.

2. Click Disconnect to disconnect the DL850E/DL850EV. The detected unit area and channel 
configuration area of the System Configuration window are cleared.

   

Disconnect button

Cleared when disconnected

3. Search for the DL850E/DL850EV you want to connect to next, and establish a connection.
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4.1 Measuring Voltage and Current

Set the measurement conditions for measuring voltage using the voltage measurement module (701250, 
701251, 701255, 701267, 701261, 701262, 701265, 701275, 720210, 720211, 720220, 720221, 720254, 
720250, 720266, or 720268). For details on the settings, see the DL850E/DL850EV User’s Manual.

1. Click the Channel Settings button, or click Channel Settings on the Acquisition menu.

   
Channel Settings buttonDisplays the Acquisition menu

Moves to the Measurement (FreeRun) 
Settings window (see chapter 5)
Cancels the settings and closes the window

Applies the settings and closes the window

Set vertical scales (vertical axis sensitivities).
The options vary depending on the probe attenuation setting.

Set bandwidth limits.
Detail Settings
Turns scaling on and off

Moves to the System Configuration Window 
(see chapter 3)

Scroll bar

Scroll bar

Move to different settings windows. Applies the settings without closing the window

Select the channels to show in the channel 
setting list (channels that are not selected 
for measurement in system configuration 
cannot be selected).

Measuring channels

Set the input coupling.
Set the probe attenuation.

Copy and paste settings in unit of lines

Set labels.

Set the unit (when scaling is ON).
Linear scaling by specifying two points
Linear scaling by specifying slope a and 
offset b of equation y = ax + b

Sets P1X to the measured value 
when the button is clicked
Sets P2X to the measured value 
when the button is clicked

Scroll bar

Chapter 4 Configuring Channels
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Measuring Channels
The measuring channel numbers that have been set to measure in the System Configuration window 
appear.

Labels (Measuring Channel Names)
You can assign names to measuring channels. Click the Label box of the measuring channel you want 
to name to display the text cursor or to highlight the existing name. Then, type the name. You can 
specify up to 16 characters for the name. By default, the channel number of the DL850E/DL850EV slot 
is assigned for the name.
The channel names specified here are used in setting the waveform display conditions and on the 
waveform window.

Setting the Coupling/Mode
Select how the input signal is coupled to the vertical control circuit from the list below.
 AC: Acquires only the AC component of the input signal.
 DC: Acquires all the components (DC and AC) of the input signal.
 GND: Checks the ground level.
To measure rms values using the 701267 or 720268, select AC-RMS or DC-RMS. For details on rms 
measurement, AC-RMS, and DC-RMS, see page 1-10.
For the 701265, 720220, 720221, or 720266, select DC or GND.

Input Coupling Settings and Frequency Response
 The frequency characteristics when AC or DC is specified are shown below.
 Note that low-frequency signals and signal components are not acquired if AC is selected as 

indicated in the figure below.

  

0 dB
–3 dB

–3 dB point*

Attenuation
0 dB

–3 dB

–3 dB point*

Attenuation

Lower frequency –3 dB point 
for AC coupling*

Input Frequency Input frequency

If AC is selected If DC is selected

*   This value differs depending on the input module. For details, see the user’s manual of 
module specifications (a separate manual).

Setting the Probe (Probe Attenuation)
Select the probe attenuation from the following according to the type of probe that you are using.
 1:1, 10:1, 100:1, 1000:1, 1 A:1 V, 10 A:1 V, 100 A:1 V, 400 A:1 V

1:1 to 1000:1 represent the probe attenuations for voltage probes.
1 A:1 V to 400 A:1 V represent the output voltage rates of current probes.
The probe attenuation is fixed to 1:1 on the 701261, 701262, 701265, 720220, 720221, 720266, and 
720268.

Note
If the probe type is not set correctly, the voltage and scale values of the input signals will not be displayed 
correctly. For example, if you use a 10:1 voltage probe but set the probe type to 1:1, the automatically 
measured amplitude of the waveform will be 1/10 the real value.

4.1  Measuring Voltage and Current
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Vertical Scale (Setting the Vertical Axis Sensitivities)
Set the vertical scale according to the signal applied to the module. The vertical scale varies depending 
on the module and probe attenuation setting.

Setting the Bandwidth Limit
High frequency components can be eliminated from the input signal. The bandwidth varies depending 
on the input module. For example, frequency bandwidth limits of 400 Hz, 4 kHz, and 40 kHz are 
available on the 701251 (HS1M16).
The frequency characteristics when the bandwidth is limited are shown below. If Full is selected,
the maximum bandwidth of the input module is used.

  
–3 dB

Approx. 400 Hz Approx. 40 kHzApprox. 4 kHz FULL

Bandwidth Limit on the 701262 (UNIVERSAL (AAF)), 701275 (ACCL/VOLT) and 
720268 (HV (with RMS/AAF))

 When measuring voltage on the 701262 (UNIVERSAL (AAF)) or 720268 (HV (with RMS/AAF)) or 
when bandwidth limit on the 701275 (ACCL/VOLT) is set to Auto, the anti-aliasing filter and low-
pass filter settings are set to values shown below according to the sample rate.
701262/701275 720268
Sample Rate Anti-Aliasing 

Filter
Low-Pass 
Filter

Sample Rate Anti-Aliasing 
Filter

Low-Pass 
Filter

100 kS/s 40 kHz OFF 1 MS/s 40 kHz 40 kHz
50 kS/s 20 kHz OFF 500 kS/s 40 kHz 40 kHz
20 kS/s 8 kHz OFF 200 kS/s 40 kHz 40 kHz
10 kS/s 4 kHz 4 kHz 100 kS/s 40 kHz 40 kHz
5 kS/s 2 kHz 4 kHz 50 kS/s 20 kHz 40 kHz
2 kS/s 800 Hz 4 kHz 20 kS/s 8 kHz 40 kHz
1 kS/s 400 Hz 400 Hz 10 kS/s 4 kHz 4 kHz
500 S/s 200 Hz 400 Hz 5 kS/s 2 kHz 4 kHz
200 S/s 80 Hz 400 Hz 2 kS/s 800 Hz 4 kHz
100 S/s 40 Hz 40 Hz 1 kS/s 400 Hz 400 Hz
50 S/s 20 Hz 40 Hz 500 S/s 200 Hz 400 Hz
5 S/s to 20 S/s 20 Hz 40 Hz 200 S/s 80 Hz 400 Hz
2 S/s or less 20 Hz 40 Hz 100 S/s 40 Hz 400 Hz
Ext sample 40 kHz OFF 50 S/s or less 40 Hz 400 Hz

Ext sample OFF OFF

 For example, for sample rates between 100 kS/s to 50 kS/s, the cutoff frequency of the anti-aliasing 
filter is set to 40% of the sample rate.

4.1  Measuring Voltage and Current
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Detail Settings
Specify detailed settings for each channel.
Click the Detail Setting box of a desired channel to open the detail setting screen.

For the 701250, 701251, 701255, 701267, 720210, 720211, 720220, 720254, 720250, 
and 720268

  

Cancels the settings and closes the window
Applies the settings and closes the window

Set the vertical scale.

Set the bandwidth limit.

Set the probe attenuation (except for 720220).

Change the channel.

Set the input coupling.

Waveform inversion

For the 701261, 701262, 701265, 720221, and 720266

  

Cancels the settings and closes the window

Applies the settings and closes the window

Set the vertical scale.

Set the bandwidth limit.

Change the channel.

Set the input coupling. (Set to DC or GND.)

Waveform inversion

For the 701275

  

Cancels the settings and closes the window
Applies the settings and closes the window

Set the probe attenuation.

Set the vertical scale.

Set the bandwidth limit.

Change the channel.

Set the input coupling. (Set to DC, AC, or GND.)

Waveform inversion

For details on the input coupling, probe attenuation, bandwidth limit, and vertical scale, see the items 
described earlier.

Wave Invert
 Inverts the waveform around zero.
 Cursor measurements is performed on the inverted waveform.

4.1  Measuring Voltage and Current
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Setting the Scaling (Linear Scaling)
Select the check box to enable linear scaling.
Acquires the measured data by linear scaling the data.
There are two linear scaling methods. One method is to set the measured values of any two points and 
their corresponding scaled values (P1-P2) and the other method is to specify the scaling coefficient a 
and offset value b (aX+b).

  

Measuring range

P1

P2

P1X P2X

P1Y

P2Y

Y = aX + b

Measured value (X)

Scale value (Y)

Setting the Unit
A unit can be assigned to the linearly scaled values. Click the Unit box of the measuring channel you 
want to set to display the text cursor or to highlight the existing unit. Then, type the unit.
Set the unit using up to four characters.

P1-P2
Specify arbitrary scale values (P1Y and P2Y) for the measured values of two arbitrary points (P1X and 
P2X). The scaling equation (y = ax + b) is derived from these four values.
• Range of measured values (P1X and P2X):  –9.99990E+25 to +9.99990E+30
• Range of scaled values (P1Y and P2Y):  –9.99990E+25 to +9.99990E+30
  However, you cannot set measured or scaled values P1 and P2 that would make value a in the 

scaling equation zero or an incalculable value.
The aX+b setting changes along with the P1-P2 setting.
You can also directly assign the current measured value to P1X or P2X.

aX+b
The results obtained from the following computation based on the specified scaling coefficient a and 
offset b
are displayed as cursor measurement values and automated measurement values of waveform 
parameters.
 Y = aX + b (where X is the measured value and Y is the linear scaling result)
  However, coefficient a cannot be set to zero.

The P1-P2 setting changes along with the aX+b setting.

Assigning a Measured Value to P1X or P2X
You can directly assign the current measured value to P1X or P2X to set the linear scaling.
After selecting the channel you want to set, click P1X Measure or P2X Measure. The measured value 
when you click the button is assigned to P1X or P2X. This feature is convenient if you want to assign 
sensor output values to P1Y and P2Y so that measured results will be scaled to sensor output values.
You cannot execute this function while the DL850E/DL850EV is measuring or recording.

4.1  Measuring Voltage and Current
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4.2 Measuring Temperature

Set the measurement conditions for measuring the temperature using the Universal Module (701261 
or 701262), Temperature, High Precision Voltage Isolation Module (701265 or 720266), or 16-CH 
Temperature, Voltage Input Module (720221).
For details on the settings, see the DL850E/DL850EV User’s Manual.

1. Click the Channel Settings button, or click Channel Settings on the Acquisition menu.

   
Channel Settings buttonDisplays the Acquisition menu

Moves to the Measurement (FreeRun) 
Settings window (see chapter 5)
Cancels the settings and closes the window

Applies the settings and closes the window

Set the thermocouple type.
Set bandwidth limits.

Detail Settings

Turns scaling on and off

Moves to the System Configuration Window 
(see chapter 3)

Move to different settings windows.
Applies the settings without closing the window

Select the channels to show in the channel 
setting list (channels that are not selected 
for measurement in system configuration 
cannot be selected).

Measuring channels

Set the input coupling (set to TC).

Copy and paste settings in unit of lines

Set labels.

Scroll bar

Scroll bar

Measuring Channels
The measuring channel numbers that have been set to measure in the System Configuration window 
appear.

Labels (Measuring Channel Names)
You can assign names to measuring channels. Click the Label box of the measuring channel you want 
to name to display the text cursor or to highlight the existing name. Then, type the name. You can 
specify up to 16 characters for the name. By default, the channel number of the DL850E/DL850EV slot 
is assigned for the name.
The channel names specified here are used in setting the waveform display conditions and on the 
waveform window.
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Setting the Coupling/Mode
Set the coupling/mode to TC.

Setting the V Scale (Thermocouple Type)
Set the vertical scale according to the thermocouple that you are using.
Select the thermocouple from below.
If the input terminal is open, the displayed value is set to a value less than or equal to the lower limit of 
the measuring range.
Type Measuring Range Type Measuring Range
K –200 to 1300°C R 0 to 1700°C
E –200 to 800°C S 0 to 1700°C
J –200 to 1100°C B 400 to 1800°C
T –200 to 400°C N 0 to 1300°C
L –200 to 900°C W 0 to 2300°C
U –200 to 400°C Au7Fe 0 to 280 K

Setting the Bandwidth Limit
High frequency components can be eliminated from the input signal. Select 2 Hz, 8 Hz, 30 Hz, or Full.

Detail Settings
Specify detailed settings for each channel.
Click the Detail Setting box of a desired channel to open the detail setting screen.

 

Cancels the settings and closes the window
Applies the settings and closes the window

Set the thermocouple type.
Set the bandwidth limit.

Change the channel.

Set the input coupling (set to TC).

Set the temperature unit.
Set the RJC.
Set the burnout.

Unit
 Set the temperature unit to °C or K. The default setting is °C.

RJC
 The DL850E/DL850EV normally performs reference junction compensation with the built-in RJC 

circuit when measuring temperature with the thermocouple. When checking the temperature 
measurement value, or when using an external reference junction (0°C), the internal reference 
junction compensation needs to be disabled.

 Select the check box to use the internal reference junction compensation.
 In normal cases, use the internal reference junction compensation.

Note
If a voltage corresponding to a certain temperature t is applied at the input with the RJC turned OFF and the 
measured temperature does not match temperature t, the DL850E/DL850EV may be damaged. Contact your 
nearest YOKOGAWA dealer.

4.2  Measuring Temperature
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Burnout
 This function is used to accurately detect a burnout in the thermocouple. If you select the check box 

and the thermocouple measurement input detects a burn out, the measured value is fixed to the 
upper limit of the measurement range of each thermocouple. By default, this setting is turned OFF (do 
not detect burn outs).

Note
Linear scaling and inverted display are not available in temperature measurements.

4.2  Measuring Temperature
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4.3 Measuring Strain

Set the measurement conditions for measuring the strain on the Strain Module (701270 or 701271).
For details on the settings, see the DL850E/DL850EV User’s Manual.

1. Click the Channel Settings button, or click Channel Settings on the Acquisition menu.

   
Channel Settings buttonDisplays the Acquisition menu

Set vertical scales (Range).

Moves to the Measurement (FreeRun) 
Settings window (see chapter 5)
Cancels the settings and closes the window

Applies the settings and closes the window

Set bandwidth limits.
Detail Settings
Turns scaling on and off

Moves to the System Configuration Window 
(see chapter 3)

Scroll bar

Move to different settings windows. Applies the settings without closing the window

Select the channels to show in the channel 
setting list (channels that are not selected 
for measurement in system configuration 
cannot be selected).

Measuring channels

Set the input coupling.
Set the probe attenuation.

Copy and paste settings in unit of lines

Set labels.

Scroll bar

Executes strain balance on all strain modules

Set the unit (when scaling is ON).
Linear scaling by specifying two points
Linear scaling by specifying slope a and 
offset b of equation y = ax + b

Sets P1X to the measured value 
when the button is clicked
Sets P2X to the measured value 
when the button is clicked

Scroll bar
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Measuring Channels
The measuring channel numbers that have been set to measure in the System Configuration window 
appear.

Labels (Measuring Channel Names)
You can assign names to measuring channels. Click the Label box of the measuring channel you want 
to name to display the text cursor or to highlight the existing name. Then, type the name. You can 
specify up to 16 characters for the name. By default, the channel number of the DL850E/DL850EV slot 
is assigned for the name.
The channel names specified here are used in setting the waveform display conditions and on the 
waveform window.

Setting the Coupling/Mode
Set the range unit to “the strain unit (×10–6 strain): μSTR” or “the output unit of the strain gauge 
transducer: mV/V.” The default value is μSTR. The mV/V range is calculated from the following 
equation.
 (mV/V) = 0.5×(μSTR)/1000

Setting the V Scale (Range)
Select from the following:
• If μSTR Is Selected
 500 μSTR, 1000 μSTR, 2000 μSTR, 5000 μSTR, 10000 μSTR, and 20000 μSTR
 For details on the measuring range, see the DL850E/DL850EV User’s Manual.
• If mV/V Is Selected
 0.25 mV/V, 0.5 mV/V, 1 mV/V, 2.5 mV/V, 5 mV/V, and 10 mV/V
 For details on the measuring range, see the DL850E/DL850EV User’s Manual.

Note
Be sure to execute balancing if you change the vertical scale.

Setting the Bandwidth Limit
High frequency components can be eliminated from the input signal. Select 10 Hz, 100 Hz, 1 kHz, or 
Full. For details, see section 4.1, “Measuring Voltage and Current.”

4.3  Measuring Strain
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Detail Settings
Specify detailed settings for each channel.
Click the Detail Setting box of a desired channel to open the detail setting screen.

Change the channel.
Cancels the settings and closes the window
Applies the settings and closes the window

Set the vertical scale.
Set the bandwidth limit.

Set the range unit.

Set the bridge voltage.
Set the gauge factor.
Executes the strain balance

Executes shunt calibration
Shunt Calibration (Only on the 701271 (STRAIN_DSUB))

Set the shunt calibration (701271).
To perform shunt calibration, select the Scaling check box.

P1:X:  Input value when the relay circuit is off (no need to set this in normal 
circumstances)

P1:Y:  Value corresponding to P1:X when the relay circuit is off (normally 0)
P2:X:  Input value when the relay circuit is on (shunt resistance, no need to 

set this in normal circumstances)
P2:Y:  Strain value corresponding to the shunt resistance when the relay 

circuit is on

Selecting the Bridge Voltage
 You can select the voltage to be applied to the bridge head.
 2V: When the bridge head resistance (bridge resistance) is 120 Ω to 1000 Ω
 5V:*  When the bridge resistance is 350 Ω to 1000 Ω
 10V:* When the bridge resistance is 350 Ω to 1000 Ω

* The bridge voltage can be set to 5 V or 10 V only if the following conditions are met.
• The bridge resistance is 350 Ω or greater.
• A strain gauge transducer that supports the bridge voltage of 5 V or 10 V.

 The bridge voltage cannot be changed while data acquisition is in progress.

Setting the Gauge Factor
 You can set the gauge factor of the strain gauge.
 Selectable range: 1.90 to 2.20 (the resolution is 0.01)
 The gauge factor is a unique constant defined for the strain gauge. It is usually described in the 

manual for the strain gauge. The gauge factor cannot be changed while data acquisition is in progress.

Gauge Factor If mV/V Is Selected
 This software allows you to set the gauge factor to any value. However, if there are no specifications 

given on the strain gauge transducer, set the gauge factor to 2.00. If the gauge factor is not 2.00, e 
is derived in the DL850E/DL850EV using the following equation.

  e = (4/K)×(V/E)  e: Measured value of the strain gauge transducer [mV/V]
        V: Voltage measured on the bridge [V]
        E: Voltage applied to the bridge [V]
        K: Gauge factor

Executing Strain Balancing
 Balancing automatically compensates the unbalanced portion of the bridge resistance. Balancing 

takes a few seconds.
 Executable range of balancing: ±10000 μSTR (if set to μSTR)
        ±5 mV/V (if set to mV/V)

Note
Perform balancing by connecting a bridge box or strain gauge transducer and without applying a load to the 
strain gauge.

4.3  Measuring Strain
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Shunt Calibration (Only on the 701271 (STRAIN_DSUB))
 The 701271 Strain Module (STRAIN_DSUB) supports shunt calibration.
 For details, see the DL850E/DL850EV User’s Manual.

Setting the Scaling (Linear Scaling)
Select the check box to enable linear scaling.
Acquires the measured data by linear scaling the data.
For details on linear scaling, see page 4-7.

Notes When Making Strain Measurements
• Be sure to execute balancing when making strain measurements.
• Select a bridge voltage of 5 V or 10 V when the bridge resistance is greater than or equal to 350 Ω. 

If a bridge voltage of 5 V or 10 V is applied when the bridge resistance is less than 350 Ω, correct 
measurements will not be made.

• If using a strain gauge transducer, use a bridge voltage in the recommended voltage range of the 
transducer.

• Correction cannot be executed if a strain gauge bridge (bridge head) or a strain gauge transducer is 
not connected to the channel on which balancing is to be executed.

• If balancing fails on any of the specified channels, an error message will be displayed.
• If the DL850E/DL850EV is turned ON, a new strain gauge is connected, or the vertical scale, bridge 

voltage, or gauge factor is changed, balancing must be performed again before making further 
measurements.

• If you switch the unit, the unit of all related parameters of the channel is switched accordingly (e.g., 
cursor measurement values).

4.3  Measuring Strain
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4.4 Measuring Acceleration

Set the measurement conditions for measuring the acceleration on the Acceleration Module (701275).
For details on the settings, see the DL850E/DL850EV User’s Manual.

1. Click the Channel Settings button, or click Channel Settings on the Acquisition menu.

   
Channel Settings buttonDisplays the Acquisition menu

Measuring channels

Set vertical scales (Gain).

Moves to the Measurement (FreeRun) 
Settings window (see chapter 5)
Cancels the settings and closes the window

Applies the settings and closes the window

Set bandwidth limits.
Detail Settings
Turns scaling on and off

Moves to the System Configuration Window 
(see chapter 3)

Scroll bar

Move to different settings windows.

Applies the settings without closing the window

Set the input coupling.
Set the probe attenuation.

Set labels.

Select the channels to show in the channel 
setting list (channels that are not selected 
for measurement in system configuration 
cannot be selected).

Copy and paste settings in unit of lines

Scroll bar

Measuring Channels
The measuring channel numbers that have been set to measure in the System Configuration window 
appear.

Labels (Measuring Channel Names)
You can assign names to measuring channels. Click the Label box of the measuring channel you want 
to name to display the text cursor or to highlight the existing name. Then, type the name. You can 
specify up to 16 characters for the name. By default, the channel number of the DL850E/DL850EV slot 
is assigned for the name.
The channel names specified here are used in setting the waveform display conditions and on the 
waveform window.
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Setting the Coupling/Mode
Set the coupling/mode to ACCL.

Setting the V Scale (Gain)
Set the gain in the range from ×0.1 to ×100.

Setting the Bandwidth Limit
High frequency components can be eliminated from the input signal. Select 40 Hz, 400 Hz, 4 kHz, 
Auto, or Full. For details, see section 4.2, “Measuring Voltage and Current.”

Detail Settings
Specify detailed settings for each channel.
Click the Detail Setting box of a desired channel to open the detail setting screen.

 

Cancels the settings and closes the window
Applies the settings and closes the window

Set the bandwidth limit.

Change the channel.

Set the input coupling
(set to ACCL).

Setting the vertical scale.

Set the bias.

Set the sensitivity.

Set the unit.

Setting the Bias
 If the bias is turned on, a 4-mA bias current is supplied to the acceleration sensor. Do not connect 

the acceleration sensor with the bias turned on.

Setting the Sensitivity
 Set the sensitivity of the acceleration sensor in the range of 0.10 mV/Unit to 2000.00 mV/Unit.

Setting the Unit
 Set the unit using up to four characters. The default setting is m/s2.

4.4  Measuring Acceleration



4-15IM DL850E-61EN

C
onfiguring C

hannels

1 

2 

3 

4 

5 

6 

7 

8 

9 

10 

11

Index

4.5 Measuring Frequency, Number of Rotations, 
Period, Duty Cycle, Power Supply Frequency, 
Pulse Width, Pulse Integration, and Velocity

Set the measurement conditions for measuring the frequency on the Frequency Module (701281 or  
720281). For details on the settings, see the DL850E/DL850EV User’s Manual.

1. Click the Channel Settings button, or click Channel Settings on the Acquisition menu.

   
Channel Settings buttonDisplays the Acquisition menu

Moves to the Measurement (FreeRun) 
Settings window (see chapter 5)
Cancels the settings and closes the window

Applies the settings and closes the window

Detail Settings
Turns scaling on and off

Moves to the System Configuration Window 
(see chapter 3)

Scroll bar

Move to different settings windows.
Applies the settings without closing the window

Select the channels to show in the channel 
setting list (channels that are not selected 
for measurement in system configuration 
cannot be selected).

Measuring channels

Set the input coupling.

Copy and paste settings in unit of lines

Set labels.

Scroll bar

Set the unit (when scaling is ON).
Linear scaling by specifying two points
Linear scaling by specifying slope a and 
offset b of equation y = ax + b

Sets P1X to the measured value 
when the button is clicked
Sets P2X to the measured value 
when the button is clicked

Scroll bar
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Settings Common to Frequency, Number of Rotations, Period, Duty 
Cycle, Power Supply Frequency, Pulse Width, Pulse Integration, and 
Velocity Measurements

Measuring Channels
The measuring channel numbers that have been set to measure in the System Configuration window 
appear.

Labels (Measuring Channel Names)
You can assign names to measuring channels. Click the Label box of the measuring channel you want 
to name to display the text cursor or to highlight the existing name. Then, type the name. You can 
specify up to 16 characters for the name. By default, the channel number of the DL850E/DL850EV slot 
is assigned for the name.
The channel names specified here are used in setting the waveform display conditions and on the 
waveform window.

Setting the Scaling (Linear Scaling)
Select the check box to enable linear scaling.
Acquires the measured data by linear scaling the data.
For details on linear scaling, see page 4-5.

Note
The coupling, probe, range, and bandwidth limit of the frequency module can be set on the detail setting 
screen.

Detail Settings
Specify detailed settings for each channel.
Click the Detail Setting box of a desired channel to open the detail setting screen.

 

Cancels the settings and closes the window

Applies the settings and closes the window

Set the input condition.

Change the channel.

Set the measurement conditions.

Set the measurement conditions
(the setup items vary depending 
on the measurement items).

4.5  Measuring Frequency, Number of Rotations, Period, Duty Cycle, Power Supply Frequency,  
Pulse Width, Pulse Integration, and Velocity
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Setting the Input Condition

Set the chattering elimination time.

Set the input coupling (when the preset is user defined).

Select a preset.

Set the bandwidth limit.

Set the voltage range (when the preset is ZeroCross or user defined).

Set the hysteresis.

Set the threshold level (when the preset is user defined).

Set the pull-up (when the preset is Pull-up 5V).

Set the probe (when the preset is Logic 5V (3V/12V/24V), ZeroCross, or user defined).

Set the slope (when the preset is Logic 5V (3V/12V/24V), Pull-up 5V, or user defined).

Preset
 Select from the following presets according to the sensor that you are using.

• Logic 5V: 5-V logic signal, 5-V output sensor, and sensor with TTL output
• Logic 3V: 3-V logic signal and 3-V output sensor
• Logic 12V: 12-V driven relay/sequence circuit and 12-V driven sensor
• Logic 24V: 24-V driven relay/sequence circuit and 24-V driven sensor
• Pull-up 5V: Open-collector output sensor and contact circuit
• ZeroCross:  Sensor/Encoder that outputs positive and negative voltages and sensor that outputs 

sine waves
• AC100V: When measuring a supply voltage of 100 VAC using the isolated probe (700929)
• AC200V: When measuring a supply voltage of 200 VAC using the isolated probe (700929)
• EM Pickup: Power-generating electromagnetic pickup
• User:   Any sensor

 For details on the settings of each preset, see the DL850E/DL850EV User’s Manual.

Setting the Input Coupling
 Set the coupling to DC or AC. You can change the setting only if the preset is set to User.

Setting the Probe (Probe Attenuation)
 Set the probe attenuation to 1:1 or 10:1. You can change the setting only if the preset is set to Logic 

5V (3V/12V/24V), ZeroCross, or User.

Setting the Range
 Set the voltage range to ±1 V, ±2 V, ±5 V, ±10 V, ±20 V, or ±50 V. You can change the setting only if 

the preset is set to ZeroCross or User.

Setting the Bandwidth Limit
 Set the bandwidth limit to 100 Hz, 1 kHz, 10 kHz, 100 kHz, or Full. You can change the setting on 

all presets. However, if the preset is set to AC100V or AC200V, the bandwidth limit cannot be set to 
Full.

Setting the Threshold Level
 Set the threshold level used to determine the period within the voltage range. You can change the 

setting only if the preset is set to User.

   

Period (when the slope is rising edge)

Threshold level

H
ys

te
re

si
s

4.5  Measuring Frequency, Number of Rotations, Period, Duty Cycle, Power Supply Frequency,  
Pulse Width, Pulse Integration, and Velocity
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Setting the Hysteresis
 Set Hys (hysteresis) to Low, Middle, or High. You can change the setting on all presets.

If Changing the Slope Setting
 Set the slope to  (rising) or  (falling).
 You can change the setting only if the preset is set to Logic 5V (3V/12V/24V), Pull-up 5V, or User.

Setting the Chatter Elimination Function
 You can change the setting on all presets. This function eliminates the chatter that occurs such 

when the contact input is turned on or off. This allows changes in the signal over the specified time 
to be ignored. Set the interval in the range of 0 to 1000 ms (1-ms resolution). This function applies 
to both the rising and falling slopes.

Setting the Pull-Up
 If the preset is set to Pull-up 5V, set whether to use pull-up.
 If using pull-up, set the input voltage in the range of 0 V to 5 V. If a voltage exceeding this range is 

applied, the internal protection circuit will cut off the pull-up circuit.

4.5  Measuring Frequency, Number of Rotations, Period, Duty Cycle, Power Supply Frequency,  
Pulse Width, Pulse Integration, and Velocity
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Measuring Frequency

 

Set the measurement item (set to Frequency).

Turn on or off pulse average and set the pulse average count.

Turns decelerating prediction on and off
Set the stop prediction.

Set the vertical scale (frequency range).
Set the offset.
Turn on or off the smoothing filter and set the moving 
average order of smoothing.

Setting the Measurement Item
Set the function to Frequency. The measurable range of frequencies is 0.01 Hz to 500 kHz.
Frequency (Hz) = 1/Tw (s)

  

Tw(s)

Setting the Vertical Scale (Frequency Range)
Set the vertical scale of frequency according to the frequency of the signal to be measured.
The selectable range is 0.1 Hz/div to 100 kHz/div in 1-2-5 steps.

Setting the Offset
Set the offset value in the range 0 to 1000 times the vertical scale or 0 to 500 kHz.
The frequency in the vertical scale indicated above can be measured around the specified offset value.
Below is an example for a vertical scale of 1 Hz and offset of 200 kHz.

  

O
ffs

et
(2

00
 k

H
z)

Vertical scale x 10 div
(10 Hz)

0 Hz

Setting the Smoothing Filter
The DL850E/DL850EV performs moving average of the order that is determined from a specified time.
Moving average order = the specified time/40 μs (the specified time: 0.0 to 1000.0 ms)

Setting the Pulse Average
Measures the input pulse by dividing the pulse by the specified number of pulses (1 to 4096 pulses). 
Specify 1 to not perform pulse averaging.

4.5  Measuring Frequency, Number of Rotations, Period, Duty Cycle, Power Supply Frequency,  
Pulse Width, Pulse Integration, and Velocity
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Turning Decelerating Prediction On and Off
Select ON to automatically compute and predict the deceleration curve from the elapsed time after the 
pulse stops. Select OFF to not perform decelerating prediction.

Setting the Stop Prediction
Set the time from the point when the pulse input stops to the point when the function determines that 
the object has stopped. The time can be set to ×1.5, ×2, ×3, ... , ×9, and ×10 (10 settings) of the pulse 
period (T) of the pulse one period before the pulse input stopped.
Select OFF to not perform stop prediction.

4.5  Measuring Frequency, Number of Rotations, Period, Duty Cycle, Power Supply Frequency,  
Pulse Width, Pulse Integration, and Velocity
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Measuring the Number of Rotations

 

Turn on or off pulse average and set the pulse average count.

Turns decelerating prediction on and off
Set the stop prediction.

Set the vertical scale (rotation pulse range).

Set the offset.

Set the number of pulses per rotation.

Set the measurement item (set to Rotation Pulse (rpm) or 
Rotation Pulse (rps)).

Turn on or off the smoothing filter and set the moving 
average order of smoothing.

Setting the Measurement Item
Set the function to Rotation Pulse (rpm) or Rotation Pulse (rps). The measurable range of rotations is 
0.01 rpm to 100000 rpm or 0.001 rps to 2000 rps.
RPMs = Frequency (Hz)/the number of pulses per rotation (Nr) × 60
RPSs = Frequency (Hz)/the number of pulses per rotation (Nr)

  

F(Hz)

The number of pulses per rotation: Nr (1 to 99999)

Setting the Vertical Scale (Rotation Pulse Range)
Set the vertical scale of rotations according to the rotations of the signal to be measured.
The selectable range is 0.1 rpm/div to 10 krpm/div in 1-2-5 steps or 0.01 rps/div to 200 rps/div in 1-2-5 
steps.

Setting the Offset
Set the offset value.
The rotations in the vertical scale indicated above can be measured around the specified offset value.
For Rotation Pulse (rpm):  0 to 100 times the rotation pulse range value or 0 to 50 krpm
For Rotation Pulse (rps): 0 to 100 times the rotation pulse range value or 0 to 1000 rps

Setting the Smoothing Filter
The DL850E/DL850EV performs moving average of the order that is determined from a specified time.
Moving average order = the specified time/40 μs (the specified time: 0.0 to 1000.0 ms)

Setting the Pulse Average
Measures the input pulse by dividing the pulse by the specified number of pulses (1 to 4096 pulses). 
Specify 1 to not perform pulse averaging.

Turning Decelerating Prediction On and Off
Select ON to automatically compute and predict the deceleration curve from the elapsed time after the 
pulse stops. Select OFF to not perform decelerating prediction.

4.5  Measuring Frequency, Number of Rotations, Period, Duty Cycle, Power Supply Frequency,  
Pulse Width, Pulse Integration, and Velocity
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Setting the Stop Prediction
Set the time from the point when the pulse input stops to the point when the function determines that 
the object has stopped. The time can be set to ×1.5, ×2, ×3, ... , ×9, and ×10 (10 settings) of the pulse 
period (T) of the pulse one period before the pulse input stopped.
Select OFF to not perform stop prediction.

Setting the Number of Pulses per Rotation
Set the number of pulses per rotation of the measured signal in the range of 1 to 99999 to determine 
the number of rotations.

4.5  Measuring Frequency, Number of Rotations, Period, Duty Cycle, Power Supply Frequency,  
Pulse Width, Pulse Integration, and Velocity
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Measuring Period

 

Set the measurement item (set to Period).

Turn on or off pulse average and set the pulse average count.

Turns decelerating prediction on and off
Set the stop prediction.

Set the vertical scale (period range).
Set the offset.

Turn on or off the smoothing filter and set the moving 
average order of smoothing.

Setting the Measurement Item
Set the function to Period. The measurable range of period is 2 μs to 50 s.
Period (s) = Tw (s)

  

Tw(s) 

Setting the Vertical Scale (Period Range)
Set the vertical scale of period according to the period of the signal to be measured.
The selectable range is 10 μs to 5 s in 1-2-5 steps.

Setting the Offset
Set the offset value in the range 0 to 1000 times the vertical scale or 0 to 50 s.
The period in the vertical scale indicated above can be measured around the specified offset value.

Setting the Smoothing Filter
The DL850E/DL850EV performs moving average of the order that is determined from a specified time.
Moving average order = the specified time/40 μs (the specified time: 0.0 to 1000.0 ms)

Setting the Pulse Average
Measures the input pulse by dividing the pulse by the specified number of pulses (1 to 4096 pulses). 
Specify 1 to not perform pulse averaging.

Turning Decelerating Prediction On and Off
Select ON to automatically compute and predict the deceleration curve from the elapsed time after the 
pulse stops. Select OFF to not perform decelerating prediction.

Setting the Stop Prediction
Set the time from the point when the pulse input stops to the point when the function determines that 
the object has stopped. The time can be set to ×1.5, ×2, ×3, ... , ×9, and ×10 (10 settings) of the pulse 
period (T) of the pulse one period before the pulse input stopped.
Select OFF to not perform stop prediction.

4.5  Measuring Frequency, Number of Rotations, Period, Duty Cycle, Power Supply Frequency,  
Pulse Width, Pulse Integration, and Velocity
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Measuring Duty Cycle

 

Set the measurement item (set to Duty).
Set the vertical scale (duty cycle range).
Set the offset.

Turn on or off the smoothing filter and set 
the moving average order of smoothing.

Set the timeout period.

Set the measurement pulse.
Set whether to measure the duty cycle of the positive 
or negative pulse.

Setting the Measurement Item
Set the function to Duty. The measurable range of duty cycle is 0 to 100%.
Duty cycle = Thigh (s)/Tw (s) (if the measured pulse is positive)
Duty cycle = Tlow (s)/Tw (s) (if the measured pulse is negative)

  Thigh(s)

Tw(s)

Tlow(s)

Setting the Vertical Scale (Duty Cycle Range)
Set the vertical scale of duty cycle according to the duty cycle of the signal to be measured.
Select 1%/div, 2%/div, 5%/div, 10%/div, or 20%/div.

Setting the Offset
Set the offset value.
The duty cycle in the vertical scale indicated above can be measured around the specified offset value.
Selectable range: 0 to 100%

Setting the Smoothing Filter
The DL850E/DL850EV performs moving average of the order that is determined from a specified time.
Moving average order = the specified time/40 μs (the specified time: 0.0 to 1000.0 ms)

Setting the Measurement Pulse
Set whether to measure the duty cycle of the pulse width above the threshold level (positive) or the 
duty cycle of the pulse width below the threshold level (negative).

Setting the Timeout Period
Set the timeout period. You can set this value when the frequency module is the 701281 (module 
version 0x04 or later) or the 720281.
Selectable range: 0.00001s (10 µs) to 80 s

4.5  Measuring Frequency, Number of Rotations, Period, Duty Cycle, Power Supply Frequency,  
Pulse Width, Pulse Integration, and Velocity
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Measuring Power Supply Frequency

 

Set the measurement item (set to Power Supply Freq.).

Turn on or off pulse average and set the pulse average count.

Set the vertical scale (frequency range).

Set the center frequency.

Turn on or off the smoothing filter and set the moving 
average order of smoothing.

Setting the Measurement Item
Set the function to Power Supply Frequency.
The measurable range of power supply frequency is (50 Hz, 60 Hz, 400 Hz) ±20 Hz.
Power supply frequency (Hz) = 1/Tw (s)
Resolution:  0.01 Hz

  
Tw(s)

Setting the Vertical Scale (Frequency Range)
Set the vertical scale of frequency according to the power supply frequency of the signal to be 
measured.
Select 0.1 Hz/div, 0.2 Hz/div, 0.5 Hz/div, 1 Hz/div, or 2 Hz/div.
Measurement is possible in the center frequency ± vertical scale x 10.

Setting the Smoothing Filter
The DL850E/DL850EV performs moving average of the order that is determined from a specified time.
Moving average order = the specified time/40 μs (the specified time: 0.0 to 1000.0 ms)

Setting the Pulse Average
Measures the input pulse by dividing the pulse by the specified number of pulses (1 to 4096 pulses). 
Specify 1 to not perform pulse averaging.

Set the center frequency.
Set the center frequency of the measuring range.
Select 50 Hz, 60 Hz, or 400 Hz.

4.5  Measuring Frequency, Number of Rotations, Period, Duty Cycle, Power Supply Frequency,  
Pulse Width, Pulse Integration, and Velocity
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Measuring the Pulse Width

 

Set the measurement item (set to Pulse Width).
Set the vertical scale (pulse width range).
Set the offset.

Turn on or off the smoothing filter and set 
the moving average order of smoothing.

Set the measurement pulse.
Set whether to measure the pulse width of the positive 
or negative pulse.

Setting the Measurement Item
Set the function to Pulse Width. The measurable range of pulse width is 1 μs to 50 s.
Pulse width = Thigh(s)  (when the measurement pulse is set to Positive)
Pulse width = Tlow(s) (when the measurement pulse is set to Negative)

  
Thigh(s) Tlow(s)

Set the Vertical Scale (pulse width range).
Set the vertical scale of pulse width according to the pulse width of the signal to be measured.
The selectable range is 10 μs/div to 5 s/div in 1-2-5 steps.

Setting the Offset
Set the offset value.
The pulse width in the vertical scale indicated above can be measured around the specified offset 
value.
The selectable range is 0 to 100 times the pulse width range value or 0 to 50 s.

Setting the Smoothing Filter
The DL850E/DL850EV performs moving average of the order that is determined from a specified time.
Moving average order = the specified time/40 μs (the specified time: 0.0 to 1000.0 ms)

Setting the Measurement Pulse
Set whether to measure the pulse width above the threshold level (positive) or the pulse width below 
the threshold level (negative).

4.5  Measuring Frequency, Number of Rotations, Period, Duty Cycle, Power Supply Frequency,  
Pulse Width, Pulse Integration, and Velocity
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Measuring Pulse Integration

 

Set the measurement item (set to Pulse Integration).
Set the vertical scale (pulse integration range).
Set the offset.

Set the unit/pulse (physical amount per pulse).

Turn on or off pulse average and set the pulse average count.

Turns over-limit reset on and off
Set the unit.
Resets the integrated value

Turn on or off the smoothing filter and set the moving 
average order of smoothing.

Setting the Measurement Item
Set the function to Pulse Integration. The measurable range of pulse integration is 0  to 2×109 counts.
Pulse integration quantity = N (count) × physical quantity per pulse (I)
Set the physical quantity per pulse (I) to distance or flow rate.

  
N (count)

l

Set the Vertical Scale (pulse integration range).
Set the vertical scale of pulse integration according to the pulse integration of the signal to be measured.
The selectable range is 10.0E-21/div to 500.0E+18/div in 1-2-5 steps.

Setting the Offset
Set the offset value.
The pulse integration in the vertical scale indicated above can be performed around the specified 
offset value.
Range:  100 times the pulse integration range value or 1.0000E+22

Setting the Smoothing Filter
The DL850E/DL850EV performs moving average of the order that is determined from a specified time.
Moving average order = the specified time/40 μs (the specified time: 0.0 to 1000.0 ms)

Setting the Pulse Average
Measures the input pulse by dividing the pulse by the specified number of pulses (1 to 4096 pulses). 
Specify 1 to not perform pulse averaging.

Setting the Unit/Pulse
Set the physical quantity per pulse in the range of –9.9999E+30 to 9.9999E+30.

Setting the Over Limit
Set Over Limit to ON to automatically reset the pulse count when the range is exceeded.

4.5  Measuring Frequency, Number of Rotations, Period, Duty Cycle, Power Supply Frequency,  
Pulse Width, Pulse Integration, and Velocity
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Setting the Unit
If necessary, set the pulse integration unit using up to four characters.

Executing Reset
Resets the integrated value. Use this to reset the value integrated up to now.

4.5  Measuring Frequency, Number of Rotations, Period, Duty Cycle, Power Supply Frequency,  
Pulse Width, Pulse Integration, and Velocity
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Measuring the Velocity

 

Set the measurement item (set to Velocity).

Turns decelerating prediction on and off
Set the stop prediction.

Set the vertical scale (velocity range).

Set the offset.

Set the velocity/pulse (velocity per pulse).
Set the time unit to Hour, Minute, or Second.
Set the unit.

Turn on or off pulse average and set the pulse average count.

Turn on or off the smoothing filter and set the moving 
average order of smoothing.

Setting the Measurement Item
Set the function to Velocity. This function measures the velocity corresponding to a pulse signal.
The measurable pulse signal frequency range is 0.01 Hz to 200 kHz.
Velocity (km/h) = (distance per pulsel(km) / Tw(s))×3600
Velocity (m/s) = distance per pulsel(m) / Tw(s)

  

Tw(s)

Distance per pulse (l)

Setting the Vertical Scale (Velocity Range)
Set the vertical scale of velocity according to the velocity of the signal to be measured.
The selectable range is 10.0E-21/div to 500.0E+18/div in 1-2-5 steps.

Setting the Offset
Set the offset value in the range 0 to 1000 times the vertical scale or 0 to 1.0000E+22.
The velocity in the vertical scale indicated above can be measured around the specified offset value.

Setting the Smoothing Filter
The DL850E/DL850EV performs moving average of the order that is determined from a specified time.
Moving average order = the specified time/40 μs (the specified time: 0.0 to 1000.0 ms)

Setting the Pulse Average
Measures the input pulse by dividing the pulse by the specified number of pulses (1 to 4096 pulses). 
Specify 1 to not perform pulse averaging.

Turning Decelerating Prediction On and Off
Select ON to automatically compute and predict the deceleration curve from the elapsed time after the 
pulse stops. Select OFF to not perform decelerating prediction.

4.5  Measuring Frequency, Number of Rotations, Period, Duty Cycle, Power Supply Frequency,  
Pulse Width, Pulse Integration, and Velocity
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Setting the Stop Prediction
Set the time from the point when the pulse input stops to the point when the function determines that 
the object has stopped. The time can be set to ×1.5, ×2, ×3, ... , ×9, and ×10 (10 settings) of the pulse 
period (T) of the pulse one period before the pulse input stopped.
Select OFF to not perform stop prediction.

Setting the Distance/Pulse
Set the velocity per pulse in the range of –9.9999E+30 to 9.9999E+30.

Setting the Time Unit
Set the time unit to Hour, Minute, or Second.
The output is automatically converted to velocity based on the specified time unit.

Setting the Unit
Set the velocity unit using up to four characters. The default value is m/s.

4.5  Measuring Frequency, Number of Rotations, Period, Duty Cycle, Power Supply Frequency,  
Pulse Width, Pulse Integration, and Velocity
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4.6 Measuring Logic Signals

Set the measurement conditions for measuring the logic signals on the Logic Input Module (720230).
For details on the settings, see the DL850E/DL850EV User’s Manual.

1. Click the Channel Settings button, or click Channel Settings on the Acquisition menu.

   
Channel Settings buttonDisplays the Acquisition menu

Moves to the Measurement (FreeRun) 
Settings window (see chapter 5)
Cancels the settings and closes the window

Applies the settings and closes the window

Detail Settings

Moves to the System Configuration Window 
(see chapter 3)

Scroll bar

Move to different settings windows.
Applies the settings without closing the window

Measuring channels
Set labels.

Select the channels to show in the channel 
setting list (channels that are not selected 
for measurement in system configuration 
cannot be selected).

Copy and paste settings in unit of lines

Scroll bar

Measuring Channels
The measuring channel numbers that have been set to measure in the System Configuration window 
appear.

Labels (Measuring Channel Names)
You can assign names to measuring channels. Click the Label box of the measuring channel you want 
to name to display the text cursor or to highlight the existing name. Then, type the name. You can 
specify up to 16 characters for the name. By default, the channel number of the DL850E/DL850EV slot 
is assigned for the name.
The channel names specified here are used in setting the waveform display conditions and on the 
waveform window.
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Detail settings

 

Cancels the settings and closes the window

Applies the settings and closes the window

Set the bit names.

Change the channel.

Set the bit mapping.

Turns the display on and off

Set the chatter elimination.

Bit Mapping
 Select from the following:
 Fixed: Space is provided even for bits that are hidden.
 Auto:   Space is not provided for bits that are hidden. Only the bits that are shown are displayed in 

order from the top.

Turning the Bit Display On and Off
 Select whether to show or hide the waveform of each bit.

Bit Name
 You can assign bit names using up to 16 characters to be displayed.

Chattering Elimination
 Select whether to eliminate chattering for each bit. When eliminating chattering, set the elimination 

time.
  OFF (not eliminate chattering), 5msec, 10msec, 20msec, 50msec, 100msec

4.6  Measuring Logic Signals
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4.7 Monitoring CAN Bus, LIN Bus, or SENT Signals 
(DL850EV)

When monitoring CAN bus, LIN bus, or SENT signals using a CAN Bus Monitor Module (720240), 
CAN & LIN Bus Monitor Module (720241), CAN/CAN FD Monitor Module (720242), or SENT Monitor 
Module (720243), this software can only be used to set the channel labels.
For other settings, configure them from the DL850EV.
For details on the settings, see the DL850EV User’s Manual (IM DL850E-01EN or IM DL850E-02EN). 
YOKOGAWA’s free software Symbol Editor is convenient for setting CAN bus or LIN bus signals. You 
can download Symbol Editor from YOKOGAWA website.
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4.8  Monitoring Power Math and Real Time Math 
Waveforms

When monitoring power math waveforms (/G5 option) or real time math waveforms  
(/G3 option) on the DL850E/DL850EV, this software can be used only to set the labels of channels.
For other settings, configure them from the DL850E/DL850EV.
For details on the settings, see the DL850E/DL850EV User’s Manual (IM DL850E-51EN).
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5.1 Setting the Measuring Mode and Acquisition 
Mode

1. Click the FreeRun Settings (measurement settings) button, or click FreeRun Settings on 
the Acquisition menu.

   
FreeRun Settings (measurement settings) buttonDisplays the Acquisition menu

Set the measuring mode (fixed to Free Run).
Set the acquisition mode.

Moves to the File Settings screen 
(see chapter 6)

Cancels the settings and closes the window

Applies the settings and closes the window

Moves to the Channel Settings screen 
(see chapter 4)

Applies the settings without closing the window

Setting the Measuring Mode
This is fixed to Free Run.
Free Run:  Acquires data at the same time measurement is started and continues to acquire data until 

the measurement is stopped.

Setting the Acquisition Mode
Select Normal, Envelope, or Box Average.
For details on each mode, see the DL850E/DL850EV User’s Manual, IM DL850E-01EN, (pdf file).

Normal Mode
 Sampled data is stored in the acquisition memory without special processing.

Envelope Mode
 The DL850E/DL850EV determines the maximum and minimum values among the data sampled at 

the maximum sample rate for each module at a time interval that is twice the sampling period (the 
inverse of the sample rate) of Normal mode, saves the values as pairs in the acquisition memory, 
and uses the saved value pairs to display the waveforms.

Box Average Mode
 The DL850/DL850V determines the moving averages of the data sampled at the maximum sample 

rate, saves them to the acquisition memory, and uses them to display waveforms. This mode is 
available on the 701250, 701255, 720210, 720211, and 720250 modules.

Chapter 5 Setting Measurement Conditions
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5.2 Setting the Sample Rate

1. Click the FreeRun Settings (measurement settings) button, or click FreeRun Settings on 
the Acquisition menu.

   
FreeRun Settings (measurement settings) buttonDisplays the Acquisition menu

Moves to the File Settings screen 
(see chapter 6)

Moves to the Channel Settings screen 
(see chapter 4)

Applies the settings without closing the window

Set the sample rate.

Cancels the settings and closes the window

Applies the settings and closes the window

Setting the Sample Rate and Sample Interval
Set the sample rate or sample interval. Setting the sample rate automatically sets the corresponding 
sample interval and vice versa.
The sample rate or sample interval can be determined from the following equation.
 Sample rate = 1/sample interval

You can select the sample rate (sample interval) from 1 MS/s (1 μs), 500 kS/s (2 μs), 200 kS/s (5 μs), 
100 kS/s (10 μs), 50 kS/s (20 μs), 20 kS/s (50 μs), 10 kS/s (100 μs), 5 kS/s (200 μs), 2 kS/s (500 μs), 
1 kS/s (1 ms), 500 S/s (2 ms), 200 S/s (5 ms), 100 S/s (10 ms), 50 S/s (20 ms), 20 S/s (50 ms), 10 S/s 
(100 ms), and 5 S/s (200 ms).

Note
• When you confirm a new sample rate (by clicking OK, Next, or Back) in Free Run mode, the previous 

measured data in the memory and the waveform display are cleared.
• If a module with sub channels (720220, 720221, 720240, 720241, 720242, 720243, or 720254) is installed 

or if power analysis is enabled, 50 S/s to 5 S/s may not be selectable depending on the settings.

Number of Measuring Channels and Sample Rate
 The maximum sample rate varies depending on number of measuring channels.

No. of Measuring Channels Maximum Sample Rate
1 1 MS/s
2 or 3 500 kS/s
4 to 8 200 kS/s
9 to 16 100 kS/s

 No.of Measuring channels do not include subchannels.
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Maximum Sample Rate of Each Module
 If you set the sample rate to a rate that is higher than a module’s maximum sample rate, because 

the data is only updated at the module’s maximum sample rate, all the data within the module’s data 
update interval will be the same. For the maximum sample rate of each module, see the DL850E/
DL850EV User’s Manual.

5.2  Setting the Sample Rate
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5.3 Setting Division Conditions

1. Click the FreeRun Settings (measurement settings) button, or click FreeRun Settings on 
the Acquisition menu.

   
FreeRun Settings (measurement settings) buttonDisplays the Acquisition menu

Set the file division conditions.
Set the days or time.

Set the unit.
DHMS: days/hours/minutes/seconds
 s: seconds

Moves to the File Settings screen 
(see chapter 6)

Moves to the Channel Settings screen 
(see chapter 4)

Applies the settings without closing the window

Cancels the settings and closes the window

Applies the settings and closes the window

Time
Performs recording by dividing the file at specified time intervals. The time interval cannot be set to a 
value that would cause the file size to exceed 2 GB.

File Name
If sequence numbers are used for the file names, the number increases by 1.
If dates are used for the file names, the file name is set to the date and time when the file is divided.
For details on file names, see section 6.1.
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6.1 Recording Measured Data

1. Click the File Settings button, or click File Settings on the Acquisition menu.

   
File Settings buttonDisplays the Acquisition menu

The File Settings window appears.

Set the recording destination device. Recordable time

Set the recording repetition conditions.

Set auto naming.

Set the recording destination folder.

Set the file name (when Auto 
Naming is set to Numbering).

Moves to the Display Settings window 
(see chapter 7)

Moves to the Measurement (FreeRun)
Settings window (see chapter 5)

Cancels the settings and closes the window

Applies the settings and closes the window

Destination
Set the data recording destination.
PC HDD:     Records to the hard disk of the PC in which this software is installed.
DL850E HDD:   Records to the DL850E/DL850EV internal hard disk.
PC HDD+DL850E HDD: Records both to the PC hard disk and the DL850E/DL850EV internal hard disk.

The DL850E/DL850EV internal hard disk is an option. DL850E HDD and PC HDD+DL850E HDD are 
valid on models with this option.

Folder
Set the recording folder on the PC hard disk. You do not have to set the folder, if you are recording 
only to the DL850E/DL850EV internal hard disk.
Click ... to open a dialog box for browsing folders.
By default, data is recorded to the DL850EACQ folder that is created in My Documents.
Measured data is saved to a folder named according to the date within the folder specified here.
The folder name is the date followed by a sequence number. The same date folder name is used both 
on the PC and the DL850E/DL850EV.

  Year
Month Day

20131205_000 
Sequence number (000 to 999)

A folder can contain up to 1000 files. If the number of files exceeds 1000, a new folder with an 
incremented sequence number is created. However, if File Order is set to Cyclic, the specified number 
of files can be saved even if the number of files exceeds 1000.

Chapter 6 Recording Measured Data
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Name
Set the file name. A sequence number is automatically appended to the specified file name. You do not 
have to set the name if you are using the date for auto naming.

Auto Naming
To Use the Date/Time in the File Name

 The date/time (ms unit) of the recording is used for the file name. A specific file name cannot be 
specified. You cannot use this function when File Order is set to Cyclic.

   
Year

Month
Day

Hour
Minute

Second
ms

20131205_121530_100 (2013/12/05 12:15:30.100)

To Use a Sequence Number in the File Name
 A sequence number is added to a file name that you specify.

   

TEST0000

Character string
Sequence number (0000 to 9999)

File Order
You can limit the number of files that are recorded to the specified destination.
Sequential:   Records files until there is no more free space on the destination hard disk.  When the 

number of files in one folder exceeds 1000, the files are recorded to a new folder.
Cyclic:    You can specify the number of files to be recorded to the destination hard disk. If the 

number of files reaches this number, recording continues by overwriting the oldest files. 
Set the number of files in the range of 1 to 1000. File names only take on sequence 
numbers.

Note 
In Cyclic mode, files are numbered from 0000 each time you start recording. Therefore, old files with the 
same name are overwritten. If you want to keep the old files, select Sequential.

Comment
Enter any necessary comments using up to 250 characters.

6.1  Recording Measured Data
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6.2 Starting and Stopping the Monitor Operation 
(Measure)

Starting the Monitor Operation
Click the Monitor button on the toolbar, or click Start Monitor on the Acquisition menu. The DL850E/
DL850EV starts measuring, and waveforms are displayed on the software window.

 

Start Monitoring button
Stop button

Acquisition menu

When measurement is started, data is acquired in the internal memory of the DL850E/DL850EV.
When waveform display is enabled, the waveforms are displayed.

Note
• Even when measurement is started, measured data is not recorded to the hard disk of the DL850E/

DL850EV or PC.
• Recording cannot be started while monitoring is in progress. To record measured data, stop monitoring 

once, and start recording. 

Stopping Monitoring
Click the Stop button on the toolbar, or click Stop on the Acquisition menu. Measurement will stop.
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6.3 Starting and Stopping the Recording Operation

Starting the Recording Operation
Click the Rec button on the toolbar, or click Start Recording on the Acquisition menu. Measured 
values are recorded to the specified destination.

 

Start Recording button
Stop button

Acquisition menu

Note
Recording cannot be started while monitoring is in progress. To record measured data, stop monitoring once, 
and start recording.

Stopping the Recording Operation
Click the Stop button on the toolbar, or click Stop on the Acquisition menu. Recording will stop.
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7.1 Setting Display Conditions

The Acquisition Software can display the measured waveforms of channels registered to display 
groups. There are settings that apply to all display groups and settings that apply to individual 
channels.

Setting Display Groups
1. Click the Display Settings button, or click Display Settings on the Acquisition menu.

   
Display Settings buttonDisplays the Acquisition menu

The Display Settings window appears.

Set the display range.

Select the display group to be shown.

Set the display conditions 
for each channel.

Moves to the Recording (File) 
Settings window (see chapter 6)

Cancels the settings and 
closes the window

Display group tab

Graph settings
(line width, time axis unit, etc.)

Applies the settings to 
the displayed waveform

Copy and paste settings 
for each channel.

Select the channels to be registered in a display group.
Click this box and select from a list of displayed labels.

Select the channels to be 
registered in a display group.
Can be set to multiple display 
channels.

Display channel number

Applies the settings and closes 
the window
Displays the waveform screen

Graph Settings

  

Select the waveform line width.

Set the time axis scaling
(if the time axis unit is set to Points).

Applies the settings and closes the window

Cancels the settings and closes the window

Select the horizontal (time) axis.

Select the waveform display interpolation format.

Set the horizontal (time) axis unit.

Turn on and off the mark that indicates 
the most recent data (for Free Run mode).

Set the scaling factor.

Chapter 7 Display
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Setting the Display Range (for Free Run mode)
To measure in Free Run mode, you must set the X-axis range to be displayed.
Set the range in terms of the display time or the number of displayed points.
The maximum sample rate among the channels registered to the display group is displayed on the 
setting window.

Setting the Display Time
 Set the display range of the X-axis in the following range.

 Longest sample interval × 10 to M/fastest sample rate
  Longest sample interval: The longest sample interval within the same display group
   M: 4004000 (standard model)
    16016000 (/M1 model)
    32032000 (/M2 model)

 The resolution is equal to the longest sample interval × 10.

Setting the Number of Displayed Points
 Set the display range of the X-axis in terms of the number of data points.

Graph Settings
Set the following items.

Line Width
 Set the waveform line width to Thin, Medium, or Thick.

Current Mark (Free Run Mode)
 Set whether to display a mark that indicates the most recent measured data.

Time Axis Unit
 Set whether to display the time axis in absolute time, relative time from the start of the 

measurement, or using the number of displayed points.

Time Axis Scaling (When the Time Axis Unit Is Set to Points)
 Set whether to scale the time axis display. If scaling the display, set the factor per displayed point as 

well as the display unit. Set the factor in the range of 0.001 to 1000. Set the display unit using up to 
10 characters.

Interpolation
 Set the interpolation format used to connect sampled data points for displaying the waveform.
 Line:  Interpolates between two points using a straight line.
 Sine:  Interpolates between two points using the sin x/x function.
 Pulse: Interpolates between two points in a staircase pattern.
 Dot:  Does not perform interpolation.

  

DotSineLine Pulse

7.1  Setting Display Conditions
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Registering the Displayed Channels
Clicking a label box shows a list of labels of the measuring channels. Select any of the measuring 
channels. The label list shows the label names specified in the measurement settings. You can register 
up to 32 measuring channels.
The same measuring channel can also be registered to multiple display groups.
To not register a measuring channel, select None from the label list.

Selecting the Labels to Display
 Click Label Select to show a list of labels for the measuring channels that are registered. Select a 

measuring channel from the list of labels that appears. Then, click OK to assign the selected label to 
the selected display channel. Select multiple labels to assign them to the selected display channel 
and its subsequent channels. You can also turn the labels on and off for all channels collectively.

  

Select the channels to display.
Displays the channels using labels

Applies the settings and closes the window

Cancels the settings and closes the window

7.1  Setting Display Conditions
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Setting Each Channel

 

Set the waveform color.

Turns the waveform display on and off
Turns the axis display on and off

Turns on and off the scale (display range) setting (vertical scale if set to off)
Set the minimum value of the scale.

Set the maximum value of the scale.
Automatically set the scale.

Set the minimum value of the zone (display position).
Set the maximum value of the zone (display position)

Scroll bar

Auto buttons

 

Set the display style of current values.

Set the numeric display format.
Set the number of decimal places of the numeric display.

Turns the current value display on and off

Scroll bar

Set the logic waveform display (for logic modules).

Turning ON/OFF the Waveform Display and Axis Display
Set whether to show or hide the waveforms and coordinate axes of channels registered to display 
groups.

7.1  Setting Display Conditions



7-5IM DL850E-61EN

D
isplay

1 

2 

3 

4 

5 

6 

7 

8 

9 

10 

11

Index

Setting the Scale
Set the scale (display range of the vertical axis).

Turning the Scale ON/OFF
 Select the On check box to set the scale. If the check box is not selected, the vertical scale 

becomes the display range.

Minimum and Maximum Values of the Scale
 These values can be set when the scale is ON. The selectable range is –1E+30 to 1E+30.

Automatically Setting the Scale
 Click the Auto button to automatically set to the scale best suited to the measured data.

Setting Zones
Set the zones (display positions). You can display waveforms so that they don’t overlap or move the 
waveforms to positions that allow easy comparison.
The settings specified here are valid when waveforms are displayed using User Zone or Edit Zone on 
the waveform window. For details on User Zone and Edit Zone, see section 7.2.

Minimum and Maximum Values of Zones
 Set the minimum and maximum values of zones as a percentage of the vertical span of the 

waveform window.

Note
You can also set zones easily by using buttons on the waveform screen. For details, see section 7.2.

Setting the Waveform Color
The color of the waveform on the DL850E/DL850EV screen appears.
Clicking a color box opens a color dialog box. You can set any color.

 

7.1  Setting Display Conditions
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Setting the Display Format
Set the numeric display format.

Numeric Format
 Select Floating, Exp, Hex, or Auto.
 For logic waveforms, this is fixed to Auto.

Decimal Places
 Set the number of decimal places.
 This is not available for logic waveforms.

Logic Waveform Display
 This is available only for logic waveforms.
 Clicking a Logic box opens a Bit Setting dialog box.

  

Bit number
Bit name

Turns the display 
on and off

Set whether to change the display positions depending on 
the number of displayed bits (Mapping) or fix the display 
positions that allow all bit waveforms to be displayed.

Set the bit order.
  MSB:  MSB first
  LSB:  LSB first

Set the display format of values shown in the 
measurement results display window.
  Binary: Binary format
  Hex: Hexadecimal format

Set the display position.
  1/1: Full window
  1/2UP: Top half of window,
  1/2Low: Bottom half of window

Set the highlight display.
  High: Highlight the high level.
  Low: Highlight the low level.

Displays logic waveforms in bus format

Current Value
Current values can be displayed at the same time as waveforms.

Turning the Display ON/OFF
 Turn on or off the current value display.

CV Type
 Set the display style of current values to Digital, Meter, Bar, or Thermometer.

  

Digital Analog meter Bar graph Thermometer

7.1  Setting Display Conditions
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7.2 Operating the Windows

Displaying the Waveform Windows
Clicking OK on the Display Settings window in section 7.1 and starting monitoring or recording shows 
the waveform windows of display groups whose Graph Display check box is selected.
To show a waveform window that is not shown, click the corresponding display group button on the 
toolbar.

 

Waveform window

Display group button
Select the active waveform display window or 
display the waveform window.

Display Updating
When measurement is started, the waveforms of channels registered to display groups are shown.
You can stop and resume the display updating by clicking the Display Hold and Display Resume 
buttons, respectively. You can read measured values using cursors and view past waveform data while 
the display is held.

 

Start measuring
Stop measuring

Hold release (resume screen updating)
Display hold (holds the waveform display)

Note
• The data continues to be acquired to the internal memory of the DL850E/DL850EV even if the display is 

held.
• When the display is held, the displayed data may be overwritten, because the DL850E/DL850EV 

continues to measure data during this period. If this happens, the display hold feature will be automatically 
canceled.

• Display hold is valid when the sample rate is 100 kS/s or less.
• The display update may slow down during auto recording, because the recording operation takes 

precedence.
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Operating Waveform Windows

Shows and hides the zone bar display area (click here)
Turns the waveform display on and off (click here)

Change the zone.

Displays cursor values Displays current values

Displays the numeric value display area
(see section 7.1)

Expands or reduces the waveform
(see section 7.3)

Displays all scales

Full screen display

Take a waveform screen capture
(take a screen snapshot).

Acquisition count

Zone bar

Snapshot
Accumulate

Clears accumulation or snapshots
Auto play

Displays the Graph Settings window.

Adjust the brightness of 
the scale in the waveform 
display area (slide the knob)

Inverts the background 
color of the waveform 
display area (slide the knob)

Changing the Display Scale in the Window
You can change the display scale in a window while measurement is in progress or when 
measurement is stopped.
Place the cursor over the scale in the window so that the  icon appears. Right-click to display the 
scale adjustment tool buttons, or double-click to display the scale setting screen.

Auto scale
Increases the scale
Decreases the scale

Displays the scale setting screen

Shifts the waveform up
Shifts the waveform down

Executes auto scale

Set the scale values.
Enter the maximum and 
minimum numeric values.

Right-click

Executes auto scale

Set the scale values.
Enter the maximum and minimum numeric values.

Double-click

Label

Label

7.2  Operating the Windows
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Displaying Multiple Display Groups
When displaying waveforms of multiple display groups, you can cascade the windows of each display 
group or tile them.
On the Window menu, click Cascade, Tile Horizontally, or Tile Vertically. The Window menu appears 
when a waveform window is displayed.

 

Arranging Minimized Waveform Windows
 To arrange the minimized waveform windows, click Arrange Icons on the Window menu.

Changing Zones
To display waveforms using zones that have been specified in the display settings, click the User Zone 
button, or click User Zone on the View menu.
To change the zones specified in the display settings, click the Edit Zone button, or click Edit Zone 
on the View menu, and drag the top and bottom edges of the bars vertically. The zones that you 
change using Edit Zone are applied to the zones in the display settings.
Click the Full Zone button to display all waveforms in a full zone (0 to 100%). Click the Slide Zone 
button to display the slid waveforms. Click the Auto Zone button, or click Auto Zone on the View 
menu to display all waveforms so that they do not overlap. If Full Zone, Slide Zone, or Auto Zone is 
selected, the display settings are not affected.

 

Auto Zone button

View menu

Edit Zone button
Full Zone button

Slide Zone button

Assign Zone button

For edit zone

Drag this to 
change the zone.

7.2  Operating the Windows
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Displaying All Waveforms Overlapped
To display all scales, click the Multi Zone button, or click Multi Zone on the View menu. The scale is 
displayed according to the display settings.

 
Multi Zone button

Selecting the Active Waveform
Click the bar of the waveform to be activated. A triangular mark is displayed above the bar, and the 
waveform is activated. The displayed scale is the scale of the active waveform.

 
Active waveform mark

Displaying the Current Values
Click the Current Value button while the display is being updated. The current values are displayed.

 

Digital Analog meter Bar graph Thermometer
Numeric display

Current Value button

7.2  Operating the Windows
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Displaying Channel Settings and Cursor Values
To show the area that displays channel settings and cursor values, click the numeric value display 
button, or click Measure Value > Numeric Values from the View menu.
To temporarily hide the display areas, click  shown below. The Channel Info. and Numeric Values 
tabs appear at the right of the display frame. Place the pointer over these words to display the 
corresponding display area. If you move the pointer outside the display area, the display area closes.
If you click Channel Info. or Numeric Values when the display area is hidden, the display area remains 
shown even when you move the pointer outside the display area. If you click a location outside the 
display area, the display area becomes hidden.
To switch between cursor values and measured waveform parameters when the numeric value display 
area is shown, click the Cursor button or Numeric value display button, or click Cursor or Numeric 
Values on the View menu.

 

Numeric value display button

View menu

The display area is hidden.

Cursor button Closes the display area

Channel info. and
numeric value 
display area

Point or click Channel Info. 
or Numeric Values.

Point or click an area outside 
the numeric value display area.

Click      to hide the display area.

Click      to keep the numeric 
value display area showing.
(The icon changes to      .)      

7.2  Operating the Windows
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Changing the Size of the Window
Move the pointer over the window frame and drag when the pointer changes to an arrow.
To resize the window to full screen click the Full Screen button on the toolbar. Clicking the Full Screen 
button again when the screen is displayed in full screen causes the screen to return to its original size.

 
Full screen button

Displaying Past Data
When the display is held or measurement is stopped, you can display past data stored in the DL850E/
DL850EV memory by changing the waveform display position. Moving the scroll bar of a waveform 
screen changes the position of the displayed waveform and displays the past waveform. Move the 
scroll bar to the left to view older data and to the right to view newer data.
In Free Run mode, you can go back as far as the oldest data stored in the DL850E/DL850EV memory.

 

Change the display position using the scroll bar.

7.2  Operating the Windows
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Scrolling Automatically
When measurement is stopped, the DL850E/DL850EV can scroll the waveform display position 
automatically.
Click the Auto Play button, or click Auto Play > Auto Play on the View menu.
The auto play screen appears.

 
Auto Play button

 

View menu

Auto Play button

Shows or hides the auto play screen

Displays the most recent data

Displays the oldest data

Set the play speed.
Select the play source (fixed to History data).

Plays data towards older data

Plays data towards more recent data

Go to beginning Reverse Stopped Play Go to end

Set the play speed. Play source settings
(fixed to History data)

7.2  Operating the Windows
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7.3 Expanding and Reducing (Zooming) 
Waveforms

The displayed waveforms can be expanded or reduced.
To expand or reduce waveforms along the time axis in a waveform window, click the Zoom Up or 
Zoom Down button, or Zoom > Zoom Up or Zoom Down on the View menu.

 
Zoom down

Zoom up

 

View menu

Note
You can use the mouse wheel to zoom up or zoom down the Free Run mode display time.
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7.4 Accumulating Waveforms and Displaying 
Snapshots

You can use the accumulate display to accumulate waveforms and use snapshots to retain waveforms 
on the screen.

Accumulating Waveforms
After you start measurement, click the Accumulate button, or click Accumulate on the View menu.
The most recent waveform is accumulated over the existing waveforms, which are not erased from the 
display.
To stop accumulation, click the Accumulate button again, or click Accumulate on the View menu.

 

View menu Accumulate button Clear button

Clearing Accumulated Waveforms
 Click the Clear button to clear the accumulated waveforms.

Note
• If you click the Accumulate button and then automatically display waveforms from memory, you can 

accumulate past waveforms.
• You cannot adjust the window size while accumulated waveforms are displayed.
• If you change the waveform display area (for example, by turning the measurement display on or off) 

while accumulated waveforms are displayed, all accumulated waveforms will be cleared.

Taking Snapshots
After you start measurement, click the Snapshot button, or click Snapshot on the View menu.
The waveform that was displayed at the time that you clicked the Snapshot button is retained on the 
screen.

 

View menu Snapshot button
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Clearing the Previous Snapshot
 To clear a snapshot, click the arrow on the right of the Snapshot button, and click Undo.
 The most recent snapshot is cleared.

  

View menu

Clears the previous snapshot
Set the snapshot waveform color.

Clears the previous snapshot
Set the snapshot waveform color.

Menu display
Clear button

Changing the Snapshot Waveform Color
 To change the snapshot waveform color, click the arrow on the right of the Snapshot button, and 

click Settings. Specify the color on the snapshot settings screen that appears.

Clearing Snapshot Waveforms
 Click the Clear button to clear all of the displayed snapshot waveforms.

Note
• You cannot adjust the window size while snapshot waveforms are displayed.
• If you change the waveform display area (for example, by turning the measurement display on or off) 

while snapshot waveforms are displayed, all snapshot waveforms will be cleared.

7.4  Accumulating Waveforms and Displaying Snapshots
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7.5 Reading Measured Values Using Cursors

When a waveform is displayed, you can use cursors to read measured values.

Selecting the Cursor Type
There are two types of cursors: vertical and horizontal.

1. Click the arrow on the right of the Cursor button.
Select the cursor type from the displayed list.

   

Click hereCursor button

Displaying the Cursors
2. Click the Cursor button to display the cursors.

 To display cursor values, click the Numeric Value Display button.
The cursor values are displayed to the right of the waveform screen.

Vertical Cursors

  

Cursor B (dotted line)

Cursor A (solid line)

Measured data at the Cursor A position
Measured data at the Cursor B position

Difference between cursors A and B

Data number and time at the Cursor A position
Data number and time at the Cursor B position

Difference between cursors A and B

Close the numeric value 
display area

Hide the numeric value 
display area

Horizontal Cursors

  

Cursor B (dotted line)

Cursor A (solid line)
Scale value at the Cursor A position

Scale value at the Cursor B position
Difference between cursors A and B
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Note
To temporarily hide the numeric value display area, click the  mark. The numeric value display area closes 
and the words “Numeric Values” and “Channel Info” appear on the display frame. Place the pointer over 
these words to display the corresponding display area. At this point the mark is changed to .
If you click , the icon changes to , tabs for switching between display areas appear at the bottom of the 
display area, and the selected display area remains displayed.

Moving the Cursors
Move the cursors by dragging them. The cursors moves on the measured points.
Pressing the left and right arrow keys on your PC keyboard moves the cursor over the measured data 
one point at a time. This feature is useful if multiple data points exist within the time corresponding to a 
dot on the display, such as when measurement is performed at a fast sample rate.
If data measured at different sample rates is displayed in the same waveform screen, the cursor 
moves at the measured data interval of the active waveform. Be sure to activate a waveform when 
reading measured values from it using cursors. The active waveform is indicated by a triangular mark 
that is displayed above the zone bar.

Notes on Cursor Measurements
• If you measure at a sample rate that exceeds the maximum sample rate of a module, data cannot 

be acquired at the specified sample rate. The data at times when data cannot be acquired is set 
to the same value as the previous acquired data. Therefore, the measured value may not change 
even if you move the vertical cursor.

• If waveforms are displayed using Auto zone (see section 7.2), horizontal cursors cannot be used.

7.6  Reading Measured Values Using Cursors
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7.6 Starting Xviewer (Sold Separately)

You can use Xviewer, software sold separately, to display measured data that has been saved or 
perform calculations using measured data.
On the Utility menu, click Xviewer.
For information on how to use Xviewer, see the Xviewer user’s manual.

 

Note
• If you double-click a file containing operating information, Xviewer will automatically start.
• You cannot connect both Ethernet and USB interfaces simultaneously to a DL850E/DL850EV. Therefore, 

Xviewer cannot connect to a DL850E/DL850EV that is connected to this software using USB.
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8.1 Saving and Loading Setup Data

The settings of this software and the DL850E/DL850EV can be saved to a file. The saved data can be 
loaded to change the settings.

Saving Setup Data
On the File menu, click Save As or Save.

 

Disconnects from the DL850E/DL850EV 
and configures a new system

Save the setup data.

To save by specifying a name, set Save as type in the Save As dialog box to Setting Files (*.scs), and 
specify the destination and file name.

 

Chapter 8 Saving and Loading Data
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8.1  Saving and Loading Setup Data

Loading Setup Data
On the File menu, click Open.
In the Open dialog box, select Setting Files (*.sls) in the Files of Type list, and specify the file you want 
to open.
If the settings of the selected setup file differ from those of the connected DL850E/DL850EV system, 
the settings cannot be loaded.
Nor can the settings be loaded if the connected DL850E/DL850EV is measuring or recording. Execute 
any of the corrective actions.
For details, see section 2.4.
The corrective actions are described below.

Corrective Action Description
Get settings from the DL850E. Discard the settings that were loaded and receive the settings from the 

DL850E/DL850EV. The measurement or recording on the DL850E/DL850EV 
continues.

Stop measuring and send settings 
to the DL850E/DL850EV.

If the DL850E/DL850EV is measuring or recording, the settings cannot be 
updated. Stop the measuring or recording and update the DL850E/DL850EV 
settings using the settings of this software.
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8.2 Saving Waveform Screen Captures

You can save screen captures of waveforms during measurement or after measurement is stopped.
You can choose the command from the File menu or click the Snapshot button.

Saving Waveform Screen Captures
On the File menu, click Save Image.
Set the file type to Bitmap Image (*.bmp) or PNG Image (*.png), and specify the destination and file 
name.

 

Taking a Snapshot with the Snapshot Button
1. Click the arrow on the right of the Snapshot button.

   
Snapshot button Click here

2. Set the file type to BMP or PNG, and specify the destination. The file will be named 
automatically.

   

3. Click the Snapshot button.

 Every time you click the Snapshot button from this point, the waveform screen capture is saved 
to the specified destination.

File Name
 When you take screen captures using the snapshot button, a file name that consists of the display 

group number followed by a sequence number is automatically assigned to the saved files. When 
the sequence number exceeds 99999, it returns to 00000, and old data is overwritten.

   

D1_00000 

Display group number (D1 to D4)
Sequence number (00000 to 99999)
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8.3 Saving Waveform Data

Waveform data in the DL850E/DL850EV memory can be saved to a PC.

Setting the Save Destination and File Name
With the measurement stopped, on the File menu, click Save Waveform.
Specify the save destination and file name.
The file type is “Yokogawa waveform file (*.wdf).” You can view the waveforms with Xviewer, sold 
separately.

 

Select the save range.
Select the save range unit.
(Points, Absolute Time, Relative Time)

Save range information
(You can enter this when User is specified.)

Select the save range unit.
(Set to Absolute Time.)

Select the save range unit.
(Set to Relative Time.)

When setting the range to save using absolute time

When setting the range to save using relative time

Save Range
Select from the following.

All: All waveform data saved in the DL850E/DL850EV memory are saved.
Display: Waveform data in the displayed range is saved.
Cursor:  Waveform data in the cursor range is saved. You can select this option when cursors are 

displayed.
User: Waveform data in the range specified manually are saved.
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Unit
 Select the save range unit from the following.

Points:   Set the range of data to save using points. Specify the range of data to save by 
specifying the start point and the end point or the number of data points to save 
from the start point. The maximum number of data points that you can specify is the 
number of data points between the start point and end point.

Absolute Time: Set the range of data to save using date and time. Specify the start date/time and 
the end date/time or the length of time from the start time. The maximum length of 
time that you can specify is the time from the start time to the end time.

Relative Time: Set the range of data to save by specifying the relative time from the start of 
measurement. Specify the start time and the end time or the length of time from the 
start time. The maximum length of time that you can specify is the time from the 
start time to the end time.

Save Range Information
 Save range information is displayed. If Save Range is set to User, you can set the range to save.
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9.1 Synchronizing the Clock with Your PC

You can synchronize the clock of the DL850E/DL850EV to your PC’s clock.

1. On the Environment menu, click Environment Settings.

   

2. Click Settings. The DL850E/DL850EV clock is synchronized to the PC’s clock.

3. Click OK.

   

Displays the DL850E/DL850EV clock

Cancels the settings and 
closes the window

Synchronizes to the PC’s clock 
and closes the window

Note
The date/time on the DL850E/DL850EV is set to the date/time in Japan by factory default.

Chapter 9 Other Features
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9.2 Setting the Software Start-up Options

Set the how this software operates when it is started.

1. On the Environment menu, click Environment Settings.

   

 Set the start-up options.

   

Cancels the settings and closes the window
Applies the settings and closes the window

Set the start-up options.

Start-up Options
The software starts with the settings that were used when the software was closed the last time. This 
option is useful if you want to make measurements using the same system configuration as the last 
time.

Note
If you start the software with the Previous Settings check box selected and the system configuration and 
the settings of the setup file are different, a message and corrective action will appear. The message and 
corrective action vary depending on the current condition. For details, see section 2.4.
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9.3 Locking the Keys on the DL850E/DL850EV

The panel keys of the connected DL850E/DL850EV can be locked.

1. On the Environment menu, click Key-Lock.
If the keys are locked, a check mark appears in front of Key-Lock, and the KEY PROTECT key on the 
DL850E/DL850EV is illuminated.

2. To clear the key-lock, click Key-Lock on the Environment menu again.

 You can also use the KEY PROTECT key on the DL850E/DL850EV to clear the key-lock.
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9.4 Calibrating the DL850E/DL850EV

You can calibrate the connected DL850E/DL850EV or set the auto calibration.

1. On the Environment menu, click Calibration.

   

 To execute calibration, click Execute.

 To set the auto calibration, select ON or OFF.
If ON is selected, calibration is executed automatically if measurement is started a certain time after starting 
the DL850E/DL850EV.

   

Executes calibration

Turns auto calibration on and off

Closes the window

Note
You cannot execute calibration while the DL850E/DL850EV is measuring.
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9.5 Displaying the Operating Status and Showing, 
Hiding, and Undocking the Toolbars

You can show and hide various buttons, the status bar, and the operating status. You can also undock 
the toolbars (with various buttons) and the operating status display area from the window.

1. Right-click a toolbar (Standard or Operation) or the operating status display area. A menu for 
showing and hiding these items appears. Click the item you want to show to place a check 
mark. To hide the item, click it again to clear the check mark.

   

Operating information

Toolbar (Standard) Toolbar (Operation)

To temporarily hide the operating 
information, click the       mark.

Undocking from the DL850EACQ Window
Double-click these items to turn them into separate dialog boxes. To dock them again, drag them to 
their original positions or double-click them. The toolbar can be positioned at the top (original position), 
left, or right. The operating status display area can be positioned at the top, bottom, left, or right.

Where operating information will be displayed

Note
• Dialog boxes that have been separated from the window can be changed in shape by dragging.
• The operating status display area can be docked only when  is active.
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9.6 Displaying the Software Version

1. Click the  button, or click About DL850EACQ... on the Help menu.
DL850E/DL850EV Acquisition Software version information will appear.

   

   

2. Click OK. 
DL850E/DL850EV Acquisition Software version information will close.
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Chapter 10 Maintenance

10.1 Troubleshooting

Problem Probable Cause and Corrective Action
Unable to connect to the DL850E/
DL850EV.

• The USB or Ethernet cable may not be connected properly. Check the cable connection.
•  If connected over an Ethernet network, the specified IP address may be different from 

the actual IP address of the DL850E/DL850EV. Check the IP address assigned to the 
DL850E/DL850EV on the DL850E/DL850EV display.

•  Connection cannot be established if the DL850E/DL850EV is turned off. Turn on 
DL850E/DL850EV power switch.

Some waveforms are not displayed. If there are many display channels, a portion of the channels may not be displayed.  
A message indicates which channels are not displayed. To display those channels, lower 
the CPU load by decreasing the number of displayed groups, decreasing the number of 
displayed channels, lowering the sample rate, and so on.
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10.2 Messages

DL850E/DL850EV Messages
Error Code Message Explanation and Corrective Action
57 Automatic strain balancing is in progress.

Wait for a moment.
—

58 Automatic strain balancing is complete. —
59 Calibrating. 

Wait for a moment.
—

60 Calibration is complete. —
504 Out of disk space. 

Delete unnecessary files or move files to your PC 
to free up space.

Delete unnecessary files from the recording destination 
hard disk (PC or DL850E/DL850EV).

656 Calibration failure. 
Check that CH[n] of Slot[n] is available.

Check the input signal of the specified channel.

661 Strain balancing failed. 
Check that CH[n] of Slot[n] is available.

Check whether the specified channel is connected.

697 Range over occurred during shunt calibration. 
Check the input voltage or range settings.

Increase the vertical scale and execute the calibration 
again.

906 Fan stopped. 
Turn off the power immediately after stopping 
measurement and recording.

Servicing is required.

904 Buffer overrun occurred. 
It will take [n] seconds to finish recording the rest of 
the data. 
Abort recording now?

The tendency for a buffer overrun to occur increases if the 
sample rate is fast or the number of channels is large. 
If you abort the recording, the data being recorded will be 
lost.

905 Buffer overrun occurred on internal HDD. 
It will take [n] seconds to finish recording the rest of 
the data.Abort recording now?

The tendency for a buffer overrun to occur increases if the 
sample rate is fast or the number of channels is large. 
If you abort the recording, the data being recorded will be 
lost.

909 HDD is full. 
Recording to the DL850E will be stopped. 
Delete unnecessary files or move files to your PC 
to free up space.

Delete unnecessary files from the recording destination 
hard disk (PC or DL850E/DL850EV).

941 Probe power is overloaded status. 
Pull the probe and check the consumption current.

The maximum output current from the DL850E/DL850EV 
probe power supply (/P4 option) is 1300 mA. Check the 
current consumption on the connected probe.
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10.2  Messages

Software Messages
Message Explanation and Corrective Action
Cannot find units. Appears if you start the DL850E/DL850EV by specifying Previous 

Settings for the start-up option and the DL850E/DL850EV cannot be 
found. Check that: 
•  The DL850E/DL850EV is connected.
• The DL850E/DL850EV is turned ON.

The system configuration is different. Appears if you start the DL850E/DL850EV by specifying Previous 
Settings for the start-up option and the system configuration of the 
DL850E/DL850EV is different from the previous configuration.

Get settings from the DL850E. The settings will be loaded from the DL850E/DL850EV.
Stop measurement ? Appears if the exit option in the environment settings is set to End ACQ 

and you close the software while the connected DL850E/DL850EV is 
measuring.

The connected DL850E is being remotely controlled by 
another application.  
Close the other application and connect to the DL850E 
again.

This message appears if another PC is connected to the detected 
DL850E/DL850EV. Disconnect the other PC from the DL850E/
DL850EV first and then connect to the DL850E/DL850EV. This 
message also appears if you try to connect to the DL850E/DL850EV 
immediately after the software is terminated by force for some reason. 
Wait for a few seconds and connect again.

No display data. Appears if there are no channels to be displayed in the current value 
display. 
Select a display channel.

Select the target channel on the sheet. To carry out P1X Measure or P2X Measure, select the channel to be 
measured in the Measurement Settings window.

Failed to generate file Failed to save the data.
Disconnecting the DL850E. Appears if you search for and connect to an DL850E/DL850EV in the 

System Configuration window and then close the System Configuration 
window using the Cancel button. The DL850E/DL850EV will be 
disconnected.

Failed to load the setup file. The setup file is corrupt.
Cannot find Xviewer. Select Xviewer. Unable to find Xviewer (a software provided with this software). Specify 

the location of the Xviewer application.
Stopping measurement and sending settings to the 
DL850E.

If the DL850E/DL850EV is measuring, the settings cannot be updated. 
Stop the measurement and update the DL850E/DL850EV settings 
using the settings of this software.

Stop recording? Appears if the exit option in the environment settings is set to End ACQ 
and you close the software while the connected DL850E/DL850EV is 
recording.

To execute this operation, stop measurement first. Not allowed while the DL850E/DL850EV is measuring.
To execute this operation, stop recording first. Not allowed while the DL850E/DL850EV is recording.
Assign the measurement channels in Connection 
Settings.

Appears if you start a measurement without assigning channels to 
measuring groups. Click OK to open the System Configuration window.

Cannot find the selected path. Appears if the specified path to the recording folder is invalid.
Holding the display Appears while holding the waveform display.
Disconnected the unit. Appears when the DL850E/DL850EV is disconnected improperly such 

as by removing the communication cable or by turning the DL850E/
DL850EV off while connected to the DL850E/DL850EV.

Failed to display some channels because of no data in 
display time.

Appears when channels are assigned to a single display group from 
different measuring groups and those channels are set to extremely 
different sample rates and measured data is not available in a channel 
set to a low sample rate.

Cannot find File Utility. Select File Utility. Appears when the File Utility is not found. The File Utility is installed 
as an JS option of Xviewer. Check whether the Xviewer’s JS option is 
installed.

Current Firm Version is not supported, you will not be 
able to connect.

Appears when the Acquisition Software version is incompatible with 
the DL850E firmware. Update the Acquisition Software or the DL850E 
firmware.

Accumulated/Snapshot waveforms will be cleared to 
resize a waveform area.

Appears when the size of the area that is used to draw the waveform 
changes. 
To clear all the accumulated and snapshot waveforms, click OK; 
otherwise, click Cancel.
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10.2  Messages

Message Explanation and Corrective Action
Accumulated waveforms are displayed. 
Clear accumulation to resize the window.

Appears when you change the window size while accumulated or 
snapshot waveforms are displayed. 
To change the window size, clear all the accumulated waveforms and 
snapshot waveforms.

Cannot set marks more than the maximum number of 
marks(128). 

Appears when you set the 129th mark. Delete marks that you no longer 
need, and set the mark again.

Turn OFF HD Recording before Connecting the 
DL850E.

―

Turn OFF GO/NO-GO judgment before Connecting the 
DL850E.

―
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11.1 Connection to the DL850E/DL850EV

Item Specifications
Maximum number of 
connections

1

Connection type USB or Ethernet

11.2 Measurement Functions

Item Specifications
Measurement control Measurement start and stop
Measuring channels The same as the number of measuring channels on the DL850E/DL850EV
Measuring mode Free Run mode
ACQ mode Normal, Envelope, and Box Average
Clock source Internal clock
Time axis accuracy ±0.005% (under standard operating conditions)
Sample rate 5 S/s, 10 S/s, 20 S/s, 50 S/s, 100 S/s, 200 S/s, 500 S/s, 1 kS/s, 2 kS/s, 5 kS/s, 10 kS/s, 20 kS/s, 

50 kS/s, 100 kS/s, 1 MS/s
Sample interval 1/sample rate

11.3 Recording Function

Item Specifications
Recording control Recording start and stop
Recording destination PC HDD, DL850E HDD, PC+DL850E HDD (the DL850E HDD is an option)
Maximum real-time hard disk 
recording speed2

PC hard disk: 1.6 MS/s (= 100kS/s×16ch)
DL850E/DL850EV hard disk: 1.6 MS/s (= 100kS/s×16ch)

Recording time
(for Free Run mode)

Until the free space on the hard disk runs out
If the file exceeds 2 GB, the file is divided into multiple files that are 2 GB or less in size.

File designation Folder designation, file name designation, auto naming (date and sequence number), and 
comments

File order Sequential and cyclic
File format YOKOGAWA original binary format (.wdf extension)

Chapter 11 Specifications
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11.4 Functions

Display Function
Item Specifications
Display group assignment Channel assignment to display groups (up to 4 groups)
Number of display channels Up to 32 channels/group
Waveform display format T-Y
Displayed time Maximum sample interval × 10 to channel record length/maximum sample rate
Current value display Digital, bar graph, meter, and thermometer
Display scale OFF (= vertical scale), user-defined scale, and auto scale
Display axis setting Multi zone, Slide zone, and Edit zone
Graph settings Line width, alarm level display, current mark, X-axis display format, X-axis scaling, X-axis unit, 

etc.
Display interpolation Line, Sine, Pulse, Dot (no interpolation)
Accumulation display Accumulates T-Y waveforms
Snapshot The waveform that is currently being displayed can be retained on the screen as a snapshot 

waveform.
Display color setting and snapshot waveform deletion

Display control Display hold and hold release (sample rate at 100 kS/s or less in Free Run mode)
DL850E/DL850EV operation 
status monitor

Measurement status, recording status, free disk space, recording buffer status, error information, 
and recorded file information, etc.

Waveform Analysis Function
Item Specifications
Cursor Horizontal cursors and vertical cursors
Past data/history data analysis View past data/history data using a scroll bar

Auto play: Automatically displays past data or history data. Auto play, reverse play, stop, go to 
oldest data, go to most recent data, and play speed adjustment

File Function
Item Specifications
Setup file Load and save Acquisition Software settings
Waveform screen capture file Screen capture data format: BMP or PNG
Waveform data file Saves waveform data, output data format: WDF (YOKOGAWA original format)

Other Features
Item Specifications
Calibration Auto calibration and manual calibration available
Environment settings DL850E clock synchronization and start-up options
Key lock Control the DL850E/DL850EV key lock and release



Index-1IM DL850E-61EN

1 

2 

3 

4 

5 

6 

7 

8 

9 

10 

11

Index

Index

Index

A Page

AC100V ..............................................................................   4-17
AC200V ..............................................................................   4-17
acceleration measurement ........................................   1-11, 4-13
ACCL ....................................................................................   1-8
accumulate .........................................................................   1-21
accumulation ......................................................................   7-15
acquisition mode..........................................................   1-13, 5-1
ACQ mode ..........................................................................   1-13
AC-RMS ......................................................................   1-8, 1-10
active waveform.........................................................   1-19, 7-10
auto play .............................................................................   1-21
aX+b ..............................................................................   1-9, 4-5

B Page

bandwidth limit ...............................................................   1-9, 4-3
bias .....................................................................................   4-14
box average mode ................................................................   5-1
box average mode ..............................................................   1-13
bridge voltage ......................................................................  4-11
brightness adjustment ........................................................   1-19
burnout ...............................................................................   1-10

C Page

calibration .............................................................................   9-4
chattering ............................................................................   4-18
check box ...........................................................................   1-22
clock source........................................................................   1-13
communication device ..........................................................   1-7
connection ..............................................................   1-2, 3-1, 3-2
coupling ................................................................................   4-2
CPU ......................................................................................   2-1
current value data .................................................................   1-1
current value display..................................................   1-16, 7-10
cursor measurement..................................................   1-17, 7-17
cursor value .........................................................................  7-11
cyclic ............................................................................   1-15, 6-2

D Page

DC-RMS ......................................................................   1-8, 1-10
decelerating prediction .......................................................   1-12
display conditions .................................................................   7-1
display data ..........................................................................   1-1
displayed channels ...............................................................   7-3
display group ...............................................................   1-16, 7-1
display range ........................................................................   7-2
display updating....................................................................   7-7
drop-down menu.................................................................   1-22
Duty ....................................................................................   4-24

E Page

EM Pickup ..........................................................................   4-17
envelope mode .....................................................................   5-1
envelope mode ...................................................................   1-13
error messages...................................................................   10-2
exiting

Acquisition Software .......................................................   2-7
expanding, reducing ...........................................................   7-14

F Page

file information ....................................................................   1-18
file limit .........................................................................   1-15, 6-2
file name ......................................................................   1-15, 6-2
filter ............................................................................   1-11, 1-12
free run mode ..............................................................   1-13, 5-1
free run settings ....................................................................   5-1
frequency ............................................................................   4-19
frequency measurement ...................................   1-12, 4-15, 4-31

G Page

gauge factor.........................................................................  4-11
GND ......................................................................................   1-8
graph settings .......................................................................   7-2

H Page

Horizontal ..................................................................   1-17, 7-17
horizontal cursors ......................................................   1-17, 7-17
hysteresist

frequency measurement ..............................................   4-18

I Page

input coupling ................................................................   1-8, 4-2
installation

USB driver ......................................................................   2-5
Acquisition Software .......................................................   2-2

inversion ........................................................................   1-9, 4-4
IP address ............................................................................   1-7

K Page

key lock.................................................................................   9-3

L Page

linear scaling..................................................................   1-9, 4-5
lines, selection ....................................................................   1-22
Logic 3V..............................................................................   4-17
Logic 5V..............................................................................   4-17
Logic 12V............................................................................   4-17
Logic 24V............................................................................   4-17

M Page

maximum sample rate ..........................................................   5-3
measured data......................................................................   1-1
measured data, saving .........................................................   8-3
measurement and recording.................................................   1-2
measurement settings ..........................................................   5-1
measurement, starting ..........................................................   6-3
measurement state .............................................................   1-18
measurement, stopping ........................................................   6-3
measuring mode ..........................................................   1-13, 5-1
measuring range............................................................   1-9, 4-3
memory .................................................................................   2-1
menu bar ............................................................................   1-20
monitoring, stopping .............................................................   6-3
moving average ..................................................................   1-12

N Page

normal mode.........................................................................   5-1



Index-2 IM DL850E-61EN

Index
normal mode.......................................................................   1-13
numeric value display .........................................................   1-16

O Page

offset ...................................................................................   1-12
option button .......................................................................   1-22
OS ........................................................................................   2-1

P Page

P1-P2.............................................................................   1-9, 4-5
past data, displaying ...........................................................   7-12
PC system requirements ......................................................   2-1
period..................................................................................   4-23
power supply frequency......................................................   4-25
preset..................................................................................   4-17
probe ....................................................................................   4-2
probe attenuation..................................................................   1-8
pull-up .................................................................................   4-18
Pull-up 5V ...........................................................................   4-17
pulse average .....................................................................   1-12
pulse integration .................................................................   4-27
pulse width..........................................................................   4-26

R Page

recordable time ...................................................................   1-14
recording, starting .................................................................   6-4
recording, stopping ...............................................................   6-4
record state.........................................................................   1-18
remaining hard disk indicator..............................................   1-18
RJC .....................................................................................   1-10
RMS measurement.............................................................   1-10
rotations, number of............................................................   4-21

S Page

sample interval ............................................................   1-13, 5-2
sample rate ..................................................................   1-13, 5-2
Save Image ..........................................................................   8-3
Save Waveform ....................................................................   8-4
scale ...................................................................   1-16, 1-19, 7-5
scaling ..................................................................................   4-5
search .....................................................................   1-7, 3-1, 3-2
sensitivity ............................................................................   4-14
sequential ....................................................................   1-15, 6-2
setup data, loading ...............................................................   8-2
setup data, saving ................................................................   8-1
shunt calibration .................................................................   4-12
signal and data flow ..............................................................   1-1
smoothing filter ...................................................................   1-12
snapshot ....................................................................   1-21, 7-15
snapshot button ....................................................................   8-3
specifications .......................................................................  11-1
speed ..................................................................................   4-29
starting

Acquisition Software .......................................................   2-6
start-up options .....................................................................   9-2
stop prediction ....................................................................   1-12
strain balance ......................................................................  4-11
straing balancing .................................................................  4-11
strain measurement .....................................................   1-11, 4-9
system configuration.............................................................   3-3

T Page

TC .........................................................................................   1-8
temperature measurement ..........................................   1-10, 4-6
text box ...............................................................................   1-22
thermocouple ...............................................................   1-10, 4-7

toolbar.................................................................................   1-20
troubleshooting ...................................................................   10-1

U Page

uninstallation.........................................................................   2-4
USB driver ............................................................................   2-5
user.....................................................................................   4-17

V Page

Vertical .......................................................................   1-17, 7-17
vertical cursors ..........................................................   1-17, 7-17
vertical scale .........................................................................   4-3
voltage and current measurement ........................................   5-2

W Page

waveform display on/off ........................................................   7-4
waveform display, turning on/off .........................................   1-19
waveform screen capture, saving .........................................   8-3
wizard ...................................................................................   1-5
workflow................................................................................   1-3

X Page

Xviewer ...............................................................................   7-19

Z Page

ZeroCross ...........................................................................   4-17
zone display, turning on/off .................................................   1-19
zones ....................................................................   1-16, 7-5, 7-9


	List of Manuals
	Terms and Conditions of the Software License
	How to Use This Manual
	Contents
	Chapter 1	What the Acquisition Software Can Do
	1.1	Acquisition Software Overview
	1.2	System Configuration
	1.3	Channel Settings
	1.4	Measurement Conditions (FreeRun Settings)
	1.5	Recording Conditions (File Settings)
	1.6	Display Settings
	1.7	Analysis Function
	1.8	Window Description
	1.9	Other Features
	1.10	Basic Operation

	Chapter 2	Installation
	2.1	PC System Requirements
	2.2	Installing or Uninstalling the Acquisition Software
	2.3	Installing the USB Driver
	2.4	Starting and Exiting the Acquisition Software

	Chapter 3	Connecting to a DL850E/DL850EV
	3.1	Connecting Using the USB
	3.2	Connecting Using the Ethernet
	3.3	Changing the Connected Device

	Chapter 4	Configuring Channels
	4.1	Measuring Voltage and Current
	4.2	Measuring Temperature
	4.3	Measuring Strain
	4.4	Measuring Acceleration
	4.5	Measuring Frequency, Number of Rotations, Period, Duty Cycle, Power Supply Frequency, Pulse Width, Pulse Integration, and Velocity
	4.6	Measuring Logic Signals
	4.7	Monitoring CAN Bus, LIN Bus, or SENT Signals (DL850EV)
	4.8 	Monitoring Power Math and Real Time Math Waveforms

	Chapter 5	Setting Measurement Conditions
	5.1	Setting the Measuring Mode and Acquisition Mode
	5.2	Setting the Sample Rate
	5.3	Setting Division Conditions

	Chapter 6	Recording Measured Data
	6.1	Recording Measured Data
	6.2	Starting and Stopping the Monitor Operation (Measure)
	6.3	Starting and Stopping the Recording Operation

	Chapter 7	Display
	7.1	Setting Display Conditions
	7.2	Operating the Windows
	7.3	Expanding and Reducing (Zooming) Waveforms
	7.4	Accumulating Waveforms and Displaying Snapshots
	7.5	Reading Measured Values Using Cursors
	7.6	Starting Xviewer (Sold Separately)

	Chapter 8 Saving and Loading Data
	8.1	Saving and Loading Setup Data
	8.2	Saving Waveform Screen Captures
	8.3	Saving Waveform Data

	Chapter 9	Other Features
	9.1	Synchronizing the Clock with Your PC
	9.2	Setting the Software Start-up Options
	9.3	Locking the Keys on the DL850E/DL850EV
	9.4	Calibrating the DL850E/DL850EV
	9.5	Displaying the Operating Status and Showing, Hiding, and Undocking the Toolbars
	9.6	Displaying the Software Version

	Chapter 10	Maintenance
	10.1	Troubleshooting
	10.2	Messages

	Chapter 11	Specifications
	11.1	Connection to the DL850E/DL850EV
	11.2	Measurement Functions
	11.3	Recording Function
	11.4	Functions

	Index




Userʼs
Manual


Notice of 
Alterations


DL850E/DL850EV
Acquisition Software
User's Manual


IM DL850E-61EN-071  1/1
for IM DL850E-61EN 7th Edition


*IM DL850E-61EN-071*


Please make the following alterations to the User's Manual IM DL850E-61EN.


Page 1-8 Probe Attenuation and Current-to-Voltage Conversion Ratio
Change the underlined sections.


When using a probe, the attenuation setting on the DL850E/DL850EV must be set equal to the probe 
attenuation or current-to-voltage conversion ratio so that the measured voltage (current) can be read 
directly. You need to adjust the following settings.


Current Probe’s Current-to-Voltage Conversion Ratio
•  0.1 A: 1 V (10 V/A) to 50 kA: 1 V (0.02 mV/A) (1-2-5 steps)
• 250 A: 1 V(0.004 V/A)
• 400 A: 1 V(2.5 mV/A)
The values in parentheses indicate output voltage rates.
For example, if the current-to-voltage conversion ratio is 5 A: 1 V, (0.2 V/A) is indicated.


Voltage Probe’s Attenuation Ratio
1: 1 to 50 k: 1 (1-2-5 steps)


Note
···················


Page 2-7 Software and DL850E/DL850EV firmware version compatibility table
Change or add the underlined sections.


Software version  
of this software DL850E/DL850EV firmware version


··················· ···················
1.09 to 1.10 4.20 or later but earlier than 4.40 
1.11 or later 4.40 or later 


 Downloading the latest version:  
  http://tmi.yokogawa.com/products/data-acquisition-equipment/scopecorders/dl850edl850ev-


scopecorder/


Page 4-2 Setting the Probe (Probe Attenuation)
Change the underlined sections.


Select the probe attenuation from the following according to the type of probe that you are using.
 1: 1, 2: 1, 5: 1, 10: 1, 20: 1, 50: 1, 100: 1, 200: 1, 500: 1, 1000: 1, 2000: 1, 5000: 1,  


10 k: 1, 20 k:1, 50 k: 1
 Displays the voltage probe attenuation


 0.1A:1V (10V/A), 0.2A:1V (5V/A), 0.5A:1V (2V/A), 1A:1V (1V/A), 2A:1V (0.5V/A), 5A:1V (0.2V/A), 
10A:1V (0.1V/A), 20A:1V (0.05V/A), 50A:1V (0.02V/A), 100A:1V (0.01V/A), 200A:1V (0.005V/A), 
250A:1V (0.004V/A), 400A:1V (2.5mV/A), 500A:1V (0.002V/A), 1kA:1V (1mV/A), 2kA:1V (0.5mV/A), 
5kA:1V (0.2mV/A), 10kA:1V (0.1mV/A), 20kA:1V (0.05mV/A), 50kA:1V (0.02mV/A)
 Displays the current probe’s output voltage rate


The probe attenuation is fixed to 1:1 on the 701261, 701262, 701265, 720220, 720221, 720266, and 
720268.





